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Safety Instructions 

Before using the product … 
 
For your safety and effective operation, please read the safety instructions 
thoroughly before using the product. Safety Instructions should always be 
observed in order to prevent accident or risk with the safe and proper use the 
product. 

 
Instructions are divided into “Warning” and “Caution”, and the meaning of the 
terms is as follows. 
 

This symbol indicates the possibility of serious injury 
or death if some applicable instruction is violated  

 
This symbol indicates the possibility of severe or 
slight injury, and property damages if some 
applicable instruction is violated 
 

Moreover, even classified events under its  caution category may develop 
into serious accidents relying on situations. Therefore we strongly advise users 
to observe all precautions properly just like warnings. 
 

The marks displayed on the product and in the user’s manual have the 
following meanings. 

Be careful! Danger may be expected. 

Be careful! Electric shock may occur. 
 
The user’s manual even after read shall be kept available and accessible to 
any user of the product. 

Warning 

Caution 



 

Safety Instructions 

Safety Instructions for design process 
 

 

 

 

 

 

 

 

 

 

 

1. Please install a protection circuit on the exterior of PLC so that the 
whole system may operate safely regardless of failures from 
external power or PLC. Any abnormal output or operation from PLC 
may cause serious problems to safety in whole system.  
(1) Install protection units on the exterior of PLC like an interlock circuit 

that deals with opposite operations such as emergency stop, 
protection circuit, and forward/reverse rotation or install an interlock 
circuit that deals with high/low limit under its position controls. 

(2) If any system error (watch-dog timer error, module installation error, 
etc.) is detected during CPU operation in PLC, all output signals are 
designed to be turned off and stopped for safety. However, there 
are cases when output signals remain active due to device failures 
in Relay and TR which can’t be detected. Thus, you are 
recommended to install an addition circuit to monitor the output 
status for those critical outputs which may cause significant 
problems.  

2. Never overload more than rated current of output module nor 
allow to have a short circuit. Over current for a long period time may 
cause a fire . 

3. Never let the external power of the output circuit to be on earlier  
than PLC power, which may cause accidents from abnormal output or 
operation. 

4. Please install interlock circuits in the sequence program for safe 
operations in the system when exchange data with PLC or modify 
operation modes using a computer or other external equipments 
Read specific instructions thoroughly when conducting control 
operations with PLC.  

Warning 
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Safety Instructions for design process 
 

 

 

 

 

 

 
 

Safety Instructions on installation process 

 I/O signal or communication line shall be wired at least 100mm 
 away from a high-voltage cable or power line. Fail to follow this 
 instruction may cause malfunctions from noise 

Caution 

1. Use PLC only in the environment specified in PLC manual or 
general standard of data sheet. If not, electric shock, fire, 
abnormal operation of the product may be caused. 

2. Before install or remove the module, be sure PLC power is off. 
If not, electric shock or damage on the product may be caused. 

3. Be sure that every module is securely attached after adding a 
module or an extension connector. If the product is installed 
loosely or incorrectly, abnormal operation, error or dropping may 
be caused. In addition, contact failures under poor cable 
installation will be causing malfunctions as well. 

4. Be sure that screws get tighten securely under vibrating 
environments. Fail to do so will put the product under direct 
vibrations which will cause electric shock, fire and abnormal 
operation. 

5. Do not come in contact with conducting parts in each module, 
which may cause electric shock, malfunctions or abnormal 
operation. 

Caution 



 

Safety Instructions 

Safety Instructions for wiring process 
 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Prior to wiring works, make sure that every power is turned off. 
If not, electric shock or damage on the product may be caused. 

2. After wiring process is done, make sure that terminal covers 
are installed properly before its use. Fail to install the cover may 
cause electric shocks. 

Warning 

1. Check rated voltages and terminal arrangements in each 
product prior to its wiring process. Applying incorrect voltages 
other than rated voltages and misarrangement among terminals 
may cause fire or malfunctions. 

2. Secure terminal screws tightly applying with specified torque. If 
the screws get loose, short circuit, fire or abnormal operation may be 
caused. Securing screws too tightly will cause damages to the 
module or malfunctions, short circuit, and dropping. 

3. Be sure to earth to the ground using Class 3 wires for FG 
terminals which is exclusively used for PLC. If the terminals not 
grounded correctly, abnormal operation or electric shock may be 
caused. 

4. Don’t let any foreign materials such as wiring waste inside the 
module while wiring, which may cause fire, damage on the 
product or abnormal operation. 

5. Make sure that pressed terminals get tighten following the 
specified torque. External connector type shall be pressed or 
soldered using proper equipments.  

 

Caution 



 

Safety Instructions 

Safety Instructions for test-operation and 
maintenance 
 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

1. Don’t touch the terminal when powered. Electric shock or 
abnormal operation may occur. 

2. Prior to cleaning or tightening the terminal screws, let all the 
external power off including PLC power. If not, electric shock or 
abnormal operation may occur. 

3. Don’t let the battery recharged, disassembled, heated, short or 
soldered. Heat, explosion or ignition may cause injuries or fire. 

Warning 

1. Do not make modifications or disassemble each module. Fire, 
electric shock or abnormal operation may occur. 

2. Prior to installing or disassembling the module, let all the 
external power off including PLC power. If not, electric shock or 
abnormal operation may occur. 

3. Keep any wireless equipment such as walkie-talkie or cell 
phones at least 30cm away from PLC. If not, abnormal operation 
may be caused. 

4. When making a modification on programs or using run to 
modify functions under PLC operations, read and comprehend 
all contents in the manual fully. Mismanagement will cause 
damages to products and accidents. 

5. Avoid any physical impact to the battery and prevent it from 
dropping as well. Damages to battery may cause leakage from its 
fluid. When battery was dropped or exposed under strong impact, 
never reuse the battery again. Moreover skilled workers are needed 
when exchanging batteries.  

Caution 
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Safety Instructions for waste disposal 
 

 

 

 

 

 

 Product or battery waste shall be processed as industrial waste. 
The waste may discharge toxic materials or explode itself. 

Caution 
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Thank you for purchasing PLC of LS Industrial System Co.,Ltd. 
Before use, make sure to carefully read and understand the User’s Manual about the functions, performances, installation and 
programming of the product you purchased in order for correct use and importantly, let the end user and maintenance 
administrator to be provided with the User’s Manual.  
 
The User’s Manual describes the product. If necessary, you may refer to the following description and order accordingly. In 
addition, you may connect our website (http://eng.lsis.biz/) and download the information as a PDF file.  

 

 

Relevant User’s Manuals  

Title Description 

XG5000 User’s Manual 
(for XGK, XGB) 

XG5000 software user manual describing online function such as 
programming, print, monitoring, debugging by using XGK, XGB 
CPU 

XG5000 User’s Manual 
(for XGI, XGR) 

XG5000 software user manual describing online function such 
as programming, print, monitoring, debugging by using XGI, 
XGR CPU 

XGK/XGB Instructions & Programming 
User’s Manual 

User’s manual for programming to explain how to use 
instructions that are used PLC system with XGK, XGB CPU. 

XGI/XGR/XEC Instructions & Programming 
User’s Manual 

User’s manual for programming to explain how to use 
instructions that are used PLC system with XGI, XGR,XEC CPU.

XGK CPU User’s Manual 
(XGK-CPUA/CPUE/CPUH/CPUS/CPUU) 

XGK-CPUA/CPUE/CPUH/CPUS/CPUU user manual describing 
about XGK CPU module, power module, base, IO module, 
specification of extension cable and system configuration, EMC 
standard 

XGI CPU User’s Manual 
(XGI-CPUU/CPUH/CPUS) 

XGI-CPUU/CPUH/CPUS user manual describing about XGI 
CPU module, power module, base, IO module, specification of 
extension cable and system configuration, EMC standard 

XGR redundant series User’s 
Manual 

XGR- CPUH/F, CPUH/T user manual describing about XGR 
CPU module, power module, extension drive, base, IO module, 
specification of extension cable and system configuration, EMC 
standard 

 
Current XGF-AD16A manual is written based on the following version.  

 
Related OS version list 
 

Product name OS version 
XGK-CPUH, CPUS, CPUA, CPUE, CPUU V3.0 

XGI-CPUU, CPUH, CPUS V2.1 

XGR-CPUH/F, CPUH/T V1.3 

XG5000(XG-PD) V3.0 
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Chapter 1 Introduction 
This user’s manual is to describe XGF-AD16A analog input module used as associated with XGT PLC series of CPU module about 

their specifications, treatment and programming, which will be hereinafter referred to as A/D conversion module.  
Analog input module is used to convert analog signal (voltage or current input) from PLC’s external device to signed 14-bit binary data 

of digital value. 
 

 1.1 Characteristics 
 

(1) Hybrid input process 

16 channel current/voltage input can be processed at one module. 
 

(2) High speed conversion  

High speed conversion can be processed through 500 ㎲/channel. 
 

(3) High accuracy 

High conversion accuracy of ±0.2 % (ambient temperature of 25 ± 5 ) is available℃ .  
 

(4) High resolution of 1/16000  
High resolution of 1/16000 can be selected to obtain digital value of high resolution. 

 
(5) Operation parameters setting / monitoring through GUI (Graphical User Interface) 

Operation parameters setting which was by using traditional commands is available now by means of [I/O Parameters Setting] 
for which user interface is reinforced to increase user’s convenience. With [I/O Parameters Setting] used, the sequence program 
can be reduced. In addition, through [Special Module Monitoring] function, A/D conversion value can be easily monitored.  

  

(6) Various formats of digital output data provided  
4 formats of digital output data are available as specified below 

(a) Unsigned Value: 0 ~ 16000 
(b) Signed Value: -8000 ~ 8000 
(c) Precise Value: Refer to Chapter 2.2 Display based on analog input range. 
(d) Percentile Value: 0 ~ 10000 

 
(7) Input disconnection detection function 

This function is used to detect the disconnection of input circuit when 1 ~ 5 V, 4 ~ 20 mA of analog input signal range is used. 
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1.2 Terminology 
 

 

 

 

 

 

 

 

 

 

               [Fig. 1.1] Analog Quantity                             [Fig. 1.2] Example of Transducer 

 

1.2.1 Analog Quantity - A 

What is displayed in numerical value with continuous physical quantity is called Analog Quantity. Since the size of analog changes 

continuously, any middle value can be taken from it in which general physical quantities such as voltage, current, temperature, 

speed, pressure and flow are included. For example, temperature can change continuously together with time as shown in Fig. 1.1. 

Since the changing temperature can not be input directly on Analog input module, it shall be input on Analog input module through 

the transducer converting identical analog quantity of input signal to electric signal. 

1.2.2 Digital Quantity - D 

  

What is displayed in data or numerical value such as 0, 1, 2 and 3 with data or 

physical quantity is called Digital Quantity. Digital in (Fig. 1.3) stands for electronic 

technology to create, save and process the data through 0 and 1 only. Accordingly, 

the data sent or saved with digital technology will be displayed in a string of 0 and 1 

continuously used. For example, On and Off signal can be displayed in a digital 

quantity of 0 and 1. BCD and binary value is also the digital quantity. 

      

 

Analog quantity can not be directly input on PLC CPU for calculation. Thus, convert 
analog quantity to digital quantity as in Fig. 1.4 so to input on PLC CPU, which will be 
executed by Analog input module. 
In addition, in order to output the analog quantity outward, convert PLC CPU’s digital 
quantity to analog quantity, which will be executed by D/A conversion module. 
 

 

[Fig. 1.3 Digital Quantity] 
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1.2.3 Characteristics of analog/digital conversion  
(1) Voltage Input 
 

 
[Fig. 1.5] Characteristics of A/D conversion (Voltage Input) 

 
Analog input module is used to convert analog electric signal input from the external device to digital quantity. Analog input 

signal converted to digital quantity can be calculated in PLC CPU. If analog input range of -10 ~ 10 V is used in voltage type of 
Analog input module, -10 V of analog input quantity will be output with digital value of 0, and 10 V of analog input quantity will be 
output with digital value of 16000, where consequently, analog input of 1.25 ㎷ is equivalent to digital value of 1. (Fig. 1.5) 
 

(2) Current Input 
 
 
 
 
 
 
 
 
 
 

 
[Fig. 1.6] Characteristics of A/D conversion (Current Input) 

 
If analog input range of 0 ~ 20 ㎃ is used in current type of Analog input module, 0 ㎃ of analog input quantity will be output 

with digital value of 0, and 20 ㎃ of analog input quantity will be output with digital value of 16000, where consequently, analog 
input of 1.25 µA is equivalent to digital value of 1. (Fig. 1.6)  
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 1.3. New Functions
 

The new functions of A/D conversion module are as follows. 
 

Item Description 

Module 

OS 

version 

CPU OS 

version Ref. 

Hold last 

value 

When input signal exceeds effective range, holds last 

effective input value. 
V1.02 

Not 

related 
2.5 

Alarm 

function 

When input signal exceeds effective range, relevant 

alarm flag turns on. 
V1.02 

XGK 

V3.2 

XGI V3.1 

XGR 

V1.7 

2.5 
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Chapter 2 Specifications 
 

  
2.1 General Specifications 

General specifications of XGT series are as specified in Table 2.1. 

[Table 2.1] General Specifications 
No. Item Specifications Related standards 

1 Operating temp. 0 +55℃∼ ℃  

2 Storage temp. -25 +70℃∼ ℃  

3 Operating 
humidity 5 95%RH∼  (Non-condensing)  

4 Storage humidity 5 95%RH (Non∼ -condensing)  

For discontinuous vibration  
Frequency Acceleration Amplitude Number
10≤f< 57㎐ - 0.075mm 
57≤f≤150㎐ 9.8m/s2(1G) - 

For continuous vibration 
Frequency Acceleration Amplitude 

10≤f< 57㎐ - 0.035mm 

5 Vibration  

57≤f≤150㎐ 4.9m/s2(0.5G) - 

Each 10 
times in 
X,Y,Z 

directions

IEC61131-2 

6 Shocks 
* Max. impact acceleration:147㎨(15G) 
* Authorized time :11㎳ 
* Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z 
 directions) 

IEC61131-2  

Square wave impulse noise ±1,500V LSIS standard 

Electrostatic discharging Voltage : 4kV(contact 
discharging) 

IEC61131-2 
IEC61000-4-2 

Radiated electromagnetic field 
noise 27 ~ 500MHz, 10 V/m IEC61131-2, 

IEC61000-4-3 

Class Power 
module

Digital/ 
Analog I/O 

communication interface 

7 Noise 

Fast 
Transient 

/burst 
noise Voltage 2kV 1kV 

IEC61131-2 
IEC61000-4-4 

8 Ambient 
conditions No corrosive gas or dust  

9 Operating height 2000m or less  

10 Pollution 
degree 2 or less  

 

Notes  

 1) IEC (International Electrotechnical Commission): 
   An international nongovernmental organization which promotes internationally cooperated standardization in 

 electric/electronic fields publishes international standards and manages applicable estimation system related 
 with. 

2) Pollution level: An index indicating pollution level of the operating environment which decides insulation 
 performance of the devices. For instance, Pollution level 2 indicates the state generally that only 
 non-conductive pollution occurs. However, this state contains temporary conduction due to dew produced. 
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 2.2 Performance Specifications 
Performance specifications of Analog input modules are as specified in Table 2.2. 

[Table 2.2] Performance Specifications  
Specifications Item 

Voltage Current 

Analog input 

DC 1  5 V∼  
DC 0  5 V∼  
DC 0  10 V∼  

DC -10  10 V∼  
(Input Resistance: 1 MΩ min.) 

DC 4  20 m∼ A 
DC 0 ~ 20 mA 

(Input Resistance 250 Ω) 

Analog input range 
setting 

►Selecting current/voltage can be set through DIP switch.  
► Analog input range can be selected through XG5000 user’s (or sequence) program or [I/O parameter].
► Respective input ranges can be set based on channels. 

Digital output 

 
(1) Voltage Type 

        Analog input  
Digital output 

1 ~ 5 V 0 ~ 5 V 0 ~ 10 V -10 ~ 10 V 

Unsigned Value 0 ~ 16000 
Signed Value -8000 ~ 8000 

Precise Value 1000 ~ 5000 0 ~ 5000 0 ~ 10000 -10000 ~ 
10000 

Percentile Value 0 ~ 10000 
 
(2) Current Type 

       Analog input  
 
Digital output 

4 ~ 20 ㎃ 0 ~ 20 ㎃ 

Unsigned Value 0 ~ 16000 
Signed Value -8000 ~ 8000 
Precise Value 4000 ~ 20000 0 ~ 20000 

Percentile Value 0 ~ 10000 
► 14-bit binary value (data: 14 bits) 
► Format of digital output data can be set through user program or S/W package respectively based on

channels. 

Max. resolution 

 
Analog input range Resolution (1/16000) Analog input range Resolution (1/16000) 

1 ~ 5 V 0.250 mV 
0 ~ 5 V 0.3125 mV 

4 ~ 20 ㎃ 1.0 µA 

0 ~ 10 V 0.625 mV 
-10 ~ 10 V 1.250 mV 

0 ~ 20 ㎃ 1.25 µA 
 

Accuracy ±0.2% or less (when ambient temperature is 25  ±5 )℃ ℃  
±0.3% or less (when ambient temperature is 0  ~ 55 )℃ ℃  

Max. conversion 
speed 500 μs/channel 

Absolute max. input ±15 V ±30㎃ 
Analog 

input points 16 channels/1 module 

Insulation method Photo-coupler insulation between input terminal and PLC power  
(no insulation between channels) 

Terminal connected 32-point terminal 
I/O points occupied Fixed type: 64 points, Changeable type: 16 points 
Internal-consumed 

current DC 5 V: 330㎃  

Weight 115g 
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Notes  

(1) When analog input module is released from the factory, Offset/Gain value is as adjusted for respective analog input ranges, which 
is unavailable for user to change. 
(2) When analog input module is released from the factory, voltage/current selection switch is selected as current. 
(3) Offset Value: Analog input value where digital output value is 0 when digital output format is set to Unsigned Value.  
(4) Gain Value: Analog input value where digital output value is 16000 when digital output format is set to Unsigned Value. 
(5) In XGR system, you can install it at extension base. Namely, you can’t install it at basic base. 



 

 

 

 

 

Chapter 2 Specifications 
 

 

2-4 

 

2.3 Respective Designations and Functions 
 

Respective designations of the parts are as described below.  

 

2.3.1 Analog input module  

 
 

 

No. Description 

RUN LED 
① 

▶ Displays the operation status of analog input module (voltage, current) 
On: Operation normal 
Flickering: Error occurs (Refer to 9.1 for more details) 
Off: DC 5V disconnected, analog input module error 

Terminal 
② 

▶ Analog input terminal, whose respective channels can be connected with external 
devices. 

Voltage/current selection switch 
③ 

▶ switch to select voltage/current (left: voltage, right: current) 

① 

② 
③ 
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2.4 Characteristics of I/O Conversion 
 

Characteristics of I/O conversion are the inclination connected in a straight line between Offset and Gain values when converting 
analog signal (voltage or current input) from PLC’s external device to digital value. I/O conversion characteristics of analog input 
modules are as described below. 

 

Voltage input 

Digital 
output 
value

0

4000

8000

12000

16000
16191

-192
-8000

-4000

0

4000

8000
8191

-8192
0

2500

5000

7500

10000
10119

-120

DC 1 ~ 5 V

DC 0 ~ 5 V

DC 0 ~ 10 V

DC -10 ~ 10 V

1 V 5 V3 V

0 V 2.5 V 5 V

0 V 5 V 10 V

-10 V 0 V 10 V

Analog 
input 
value

Analog applicable range

Offset 
value

Gain 
value

 

 
Current input 
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2.4.1 I/O characteristics of analog input module 
Analog input module is having 16 channels for analog input, where Offset/Gain can not be adjusted by user. Voltage/current 

input range can be set through user program or [I/O parameter] of XG5000 for respective channels. Output formats of digital 
data are as specified below; 

 

(a) Unsigned Value 
(b) Signed Value 
(c) Precise Value 
(d) Percentile Value 

 

(1) If the range is DC 4 ~ 20 mA  

(a) On the XG5000 menu [I/O Parameters Setting], set [Input range] to “4 ~ 20 ㎃”. 
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(b) Digital output value for current input characteristics is as specified below. 
(Resolution (based on 1/16000): 1 μA) 

 

Analog input current (mA) Digital 
Output range 3.808 4 8 12 16 20 20.191 

Unsigned value 

 (-192 ~ 16191) 
-192 0 4000 8000 12000 16000 16191 

Signed value 

 (-8192 ~ 8191) 
-8192 -8000 -4000 0 4000 8000 8191 

Precise value 

 (3808 ~ 20191) 
3808 4000 8000 12000 16000 20000 20191 

Percentile value 

 (-120 ~ 10119) 
-120 0 2500 5000 7500 10000 10119 
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(2) If the range is DC 0 ~ 20 mA 
 (a) On the XG5000 menu [I/O Parameters Setting], set [Input range] to “0 ~ 20 ㎃”. 
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(b) Digital output value for current input characteristics is as specified below. 
(Resolution (based on 1/16000): 1.25 μA) 
 

Analog input current (mA) Digital 
Output range -0.24 0 5 10 15 20 20.23 

Unsigned value 
 (-192 ~ 16191) 

-192 0 4000 8000 12000 16000 16191 

Signed value 
 (-8192 ~ 8191) 

-8192 -8000 -4000 0 4000 8000 8191 

Precise value 
 (3808 ~ 20191) 

-240 0 5000 10000 15000 20000 20239 

Percentile value 
 (-120 ~ 10119) 

-120 0 2500 5000 7500 10000 10119 

 

(3) If the range is DC 1 ~ 5 V 

(a) On the XG5000 menu [I/O Parameters Setting], set [Input range] to “1 ~ 5 V”. 
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(b) Digital output value for voltage input characteristics is as specified below. 
(Resolution (based on 1/16000): 0.25 mV)  

 

Analog input voltage (V) Digital 
 Output range 0.952 1 2 3 4 5 5.047 
Unsigned value 

 (-192 ~ 16191) 
-192 0 4000 8000 12000 16000 16191 

Signed value 

 (-8192 ~ 8191) 
-8192 -8000 -4000 0 4000 8000 8191 

Precise value 

 (952 ~ 5048) 
952 1000 2000 3000 4000 5000 5047 

Percentile value 

 (-120 ~ 10119) 
-120 0 2500 5000 7500 10000 10119 

 

(4) If the range is DC 0 ~ 5 V 
(a) On the XG5000 menu [I/O Parameters Setting], set [Input range] to“0 ~ 5 V”.  
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D
igital output value

0

4000

8000

12000

16000
16191

-192
-8000

-4000

0

4000

8000
8191

-8192
0

2500

5000

7500

10000
10119

-120

0 V 5 V2.5 V

5059
5000

3750

2500

1250

0
-60

3.75 V1.25 V

Analog input value (voltage)  
 

(b) Digital output value for voltage input characteristics is as specified below.  
(Resolution (based on 1/16000): 0.3125 mV) 

 

Analog input voltage (V) Digital 
Output range -0.06 0 1.25 2.5 3.75 5 5.05 

Unsigned value 

 (-192 ~ 16191) 
-192 0 4000 8000 12000 16000 16191 

Signed value 

 (-8192 ~ 8191) 
-8192 -8000 -4000 0 4000 8000 8191 

Precise value 

 (-60 ~ 5060) 
-60 0 1250 2500 3750 5000 5059 

Percentile value 

 (-120 ~ 10119) 
-120 0 2500 5000 7500 10000 10119 

 



 

 

 

 

 

Chapter 2 Specifications 
 

 

2-12

 

(5) If the range is DC 0 ~ 10 V  
(a) On the XG5000 menu [I/O Parameters Setting], set [Input range] to“0 ~ 10 V”. 
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(b) Digital output value for voltage input characteristics is as specified below. 
(Resolution (based on 1/16000): 0.625 mV) 

 

 

Analog input voltage (V) Digital 
Output range -0.12 0 2.5 5 7.5 10 10.11 

Unsigned value 

 (-192 ~ 16191) 
-192 0 4000 8000 12000 16000 16191 

Signed value 

 (-8192 ~ 8191) 
-8192 -8000 -4000 0 4000 8000 8191 

Precise value 

 (-60 ~ 5059) 
-120 0 2500 5000 7500 10000 10119 

Percentile value (-
120 ~ 10119) 

-120 0 2500 5000 7500 10000 10119 

 

(6) If the range is DC-10 ~ 10 V 
 (a) On the XG5000 menu [I/O Parameters Setting], set [Input range] to “-10 ~ 10 V” 
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(b) Digital output value for voltage input characteristics is as specified below. 
(Resolution (based on 1/16000): 1.25 mV) 

 

Analog input voltage (V) Digital 
Output range -10.24 -10 -5 0 5 10 10.23 

Unsigned value 
 (-192 ~ 16191) 

-192 0 4000 8000 12000 16000 16191 

Signed value 

 (-8192 ~ 8191) 
-8192 -8000 -4000 0 4000 8000 8191 

Precise value 

 (-10240 ~ 10238) 
-10240 0 2500 5000 7500 10000 10239 

Percentile value 

 (-120 ~ 10119) 
-120 0 2500 5000 7500 10000 10119 

 

Notes  

(1) If analog input value exceeding digital output range is input, the digital output value will be kept to be the max. or the min. 
value applicable to the output range specified. For example, if the digital output range is set to unsigned value (–192 ~ 16191) 
and the digital output value exceeding 16191 or analog value exceeding –192 is input, the digital output value will be fixed as 
16191 or –192. 
(2) Offset/Gain setting for analog input module shall not be performed by user. 

 

 Voltage and current input shall not exceed ±15 V and ±30 ㎃ respectively. Rising heat may cause defects. 

Caution
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2.4.2 Accuracy 
Accuracy of digital output value does not change even if input range is changed. Fig. 2.1 shows the change range of the accuracy 

at ambient temperature of 25 ± 5 ℃ with analog input range of -10 ~ 10 V selected and digital output type of Unsigned value selected. 
±0.2% of error tolerance is acceptable at ambient temperature of 25±5 °C, and ±0.3% at ambient temperature of 0~55°C. 

0

-10 V 0 V

8000

10 V

16000

Analog input voltage

15968

16031

-32

32

 

 
[Figure 2.1] Accuracy (in case of 25 ± 5℃) 
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Functions of Analog input module are as described below in Table 2.3.  
 

[Table 2.3] List of Functions  
Function Item Details 

Channel Run/Stop setting 
Specify Run/Stop of the channel to execute A/D conversion. 
If the unused channel is set to Stop, whole Run time can be reduced.  

Input voltage/Current range 
setting 

Specify analog input range to be used 
input ranges available for voltage input, and 2 input ranges for current input 

Output data format setting 
Specify digital output type 
4 output data formats are provided in this module 

A/D conversion methods 

(1) Sampling processing 
Sampling process will be performed if A/D conversion type is not specified.

(2) Filter processing 
Used to delay the sudden change of input value. 

(3) Average processing 
Outputs average A/D conversion value based on frequency or time.  

Function to detect input 
disconnected 

If analog input with the range of 1 ~ 5 V (4 ~ 20 ㎃) is disconnected, user 
program will detect it. 

Hold last value 
(1) This function is supported at current input (4~20mA, 0~20mA) 
(2) When input signal exceeds the effective range, holds the last effective value.  

Alarm function 
(1) Separate setting is not necessary 
(2) When input signal exceeds the effective range, relevant flag turns on to let the user know 

 

There are two A/D conversion methods, sampling processing, average processing 

 

 

2.5.1 Sampling processing 
It collects analog input sign through general A/D conversion processing at a specific interval so to convert to digital. The time 

required for A/D conversion of analog input sign till saved on the memory depends on the number of channels used.  
 

(Processing time)  = (Number of Channels used) X (Conversion speed) 
 

Ex.) If the number of channels used is 3, its process time will be 
(3) X (500 µs) = 1500 μs 

 
Sampling is to calculate the sampling value of continuous analog sign at a specific interval. 

 

 

 

 2.5 Functions of Analog Input Module  
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2.5.2 Average processing  

  This process is used to execute A/D conversion of the channel designated for specified frequency or for specified time and save the 

average of the accumulated sum on memory. Average processing option and time/frequency value can be defined through user 

program or I/O parameters setting for respective channels 
 

(1) What is the average processing used for  
This process is used for A/D conversion of abnormal analog input sign such as noise to a value near to normal analog input 
sign.  

 

(2) Average processing type 
Average processing type is of time average, count average and weighted-average. 
 

(a) Time average processing 
1) Setting range: 16 ~ 16000 (ms) 
2) Average processing count within specified time is decided based on the number of channels used. 

 

Speed) Conversion( x used) Channels of(Number 
 timeSettingcount  processingAverage =  

 

Ex.1) Channels used: 1, setting time: 16000 ms 

times
ms
ms 32000

5.01
16000count  processing Average =
×

=  

 

Ex.2) Channels used: 8, setting time: 16 ms  

times
ms

ms 4
5.08

16count  processing Average =
×

=  

*1: If setting value of time average is not specified within 16 ~ 16000, RUN LED blinks at an interval of 1 second. In order to 
set RUN LED to On status, reset the setting value of time average within 16 ~ 16000 and then convert PLC CPU from 
STOP to RUN. Be sure to use request flag of error clear (UXY.19.0) to clear the error through online editing.  
*2: If any error occurs in setting value of time average, the default value 16 will be saved. 
Time average is processed after converted to average of the times inside the Analog input module. In this case, a 
remainder may be produced when setting time is divided by (number of channels used X conversion speed), which will be 
disregarded. Thus, the average processing frequency will be the quotient of [(setting time) ÷ (number of channels used x 
conversion speed)]. 

 
Ex.) If the number of channels used is 5, and setting time is 151 ms.  

151 ms ÷ (5 X 0.5 ms) = 60 times …… Remainder of 4 → 60 times 
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(b) Count average process  
1) Setting range: 2 ~ 64000 (times) 
2) The time required for average value to be saved on memory when frequency average used depends on the number of 

channels used. 
Process time = setting frequency X number of channels used X conversion speed 

 
*1: If setting value of count average is not specified within 2 ~ 64000, RUN LED blinks at an interval of 1 second. 

In order to set RUN LED to On status, reset the setting value of frequency average within 2 ~ 64000 and then 
convert PLC CPU from STOP to RUN. Be sure to use request flag of error clear (UXY.19.0) to clear the error 
through modification during RUN.. 

*2: If any error occurs in setting value of frequency average, the default value 2 will be saved. 
 

Ex.) If the number of channels used is 4, and average processing frequency is 50. 
       50 X 4 X (0.5 ms) = 25 ms 

 

 

(c) Weighted average process 
Weighted average process function is used to obtain stable digital output value by filtering (delaying) noise or sudden 

change of input value. Weighted average constant can be specified for respective channels through user program or I/O 
parameters setting. 
 

 

1) Setting range: 1 ~ 99(%) 
F[n] = (1 - α) x A[n] + α x F [n - 1] 

     F[n]: Present weighted-average output value 
     A[n]: Present A/D converted value 
     F[n-1]: Previous weighted-average output value 
     α: weighted-average constant (0.01 ~ 0.99: Previous value’s weighted value) 

 
a) If weighted value setting value is not specified within 1 ~ 99, RUN LED blinks at an interval of 1 second. In order to set 

RUN LED to On status, reset the weighted value setting value within 1 ~ 99 and then convert PLC CPU from STOP to 
RUN. Be sure to use request flag of error clear (UXY.19.0) to clear the error through online editing. 

b) If any error occurs in weighted average setting value, the default of average weighted setting value 1 will be saved. 
 

2) In the case of voltage input 
a) Analog input range: DC -10 ~ 10 V, Digital output range: 0 ~ 16000. 
b) If analog input value changes –10 V → 10 V (0 → 16000), weighted average output value based on αvalue is as 

specified below. 
 

Weighted average output value 
αvalue 

- 1 scan 2 scan 3 scan 
Remarks  

*1) 0.01 0 15840 15998 15999 1% inclined toward previous value 
*2) 0.5 0 8000 12000 14000 50% inclined toward previous value 

*3) 0.99 0 160 318 475 99% inclined toward previous value 
*1) 16000 output after about 4 scans  
*2) 16000 output after about 24 scans   
*3) 16000 output after about 1491 scans (372.75 ms for 1 channel Run) 
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3) In the case of current input 
a) Analog input current range: DC 0 ~ 20 ㎃, Digital output range: 0 ~ 16000. 
b) If analog input value changes 0 ㎃ → 10 ㎃ (0 → 8000), weighted average output value based on αvalue is as 

specified below. 
 

Filter output value 
αvalue 

- 1 scan 2 scan 3 scan 
Remarks 

*1) 0.01 0 7920 7999 7999 1% inclined toward previous value 
*2) 0.5 0 4000 6000 7000 50% inclined toward previous value 

*3) 0.99 0 80 159 237 99% inclined toward previous value 
*1) 8000 output after about 4 scans  
*2) 8000 output after about 21 scans 
*3) 8000 output after about 1422 scans (355.5 ms for 1 channel Run) 

 
4) If weighted average process function is not used, present A/D converted value will be output as it is. The weighted average 

process function takes weighted data between ‘Present A/D converted value’ and ‘Previous A/D converted value’. And the 
weighted data can be decided with [average value]. If output data shakes too much, set a big [average value]. 

 

2.5.3 Input disconnection detection function  

 

(1) Input range available 
If the input sign range of 1 ~ 5 V (4 ~ 20 ㎃) is used, the function to detect input circuit disconnected will be available. Detection 

conditions for respective input sign ranges are as described below in the table. 
 

Input signal range Voltage/Current value regarded as disconnected 
1 ~ 5 V 0.2 V or less 

4 ~ 20 mA 0.8 mA or less 
 

(2) Disconnection display for respective channels  
Detection sign of disconnection for respective input channels will be saved on UXY. 18. 

 (X stands for Base No., and Y for Slot No.) 
 

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 
Default 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

Assigned CH15 CH14 CH13 CH12 CH11 CH10 CH9 CH8 CH7 CH6 CH5 CH4 CH3 CH2 CH1 CH0

 

BIT Description 
0 Normal 
1 Disconnected 

(3) Operation   
Each bit will be set to 1 if an assigned channel is detected as disconnected, and back to 0 if connected back. In addition, each bit 
can be used to detect the disconnection in the user program together with execution conditions. 

 
(4) Program Example 

If a module is installed on Base No.0 and Slot No.2 with detection flag of disconnection used, it will be as shown below. If 
the applicable channel is detected as disconnected, the channel number detected will be written on the P area. 
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(System configuration) 

 

 

 

 

 

 

 

 

 

 

 

XGP- 
ACF2 

XGK- 
CPUH 
 

XGF- 
AD16A

Blank 
 

Blank 
 

Blank 
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2.5.4 Hold last value (Dedicated for current input) 
      When input signal exceeds the effective range, last input value is held. This function can be set for each channel by I/O 

parameter setting or user program. 
 

(1) Input range to be used 
This function can be used when you use input signal range of 4~20mA, 0~20mA. So this function can be used in current input 
module. In this function - enabled channel, only value of effective range is indicated. For example, in case output data type is 
unsigned value, if this function is disabled, output data has the -192~16191 range. But this function is enabled, output data has 
the 0~16000 range.   

 
Input current 

range 
Classification Unsigned Signed Precise Percentile 

Disable -192~16191 -8192~8191 3808~20191 -120~10119 
4 ~ 20 mA 

Enable 0~16000 -8000~8000 4000~20000 0~10000 
Disable -192~16191 -8192~8191 -240~20239 -120~10119 

0 ~ 20 mA 
Enable 0~16000 -8000~8000 0~20000 0~10000 

 
(2) Operation 

When this function is enabled and range is 4~20mA, output value corresponding to sample input value is as follows. (Output 
data type: 0~16000)   

 
Input current 

(mA) 
12 3 4 12 21 20 

Output value 8000 8000 0 12000 12000 16000 
Ref. - Hold last 

value 
- - Hold last 

value 
- 

 

2.5.5 Alarm function 

When input signal exceeds effective range, relevant flag turns on. 

 
(1) Input detection condition 

Detection condition for each input signal range is as follows. 
. 

 
Input signal range Difference Tolerance Lower limit Upper limit 

4~20 mA 16 mA 3.808 mA 20.192 mA 

0~20 mA 20 mA -0.24 mA 20.24 mA 

1~5 V 4 V 0.952 V 5.048 V 

0~5 V 5 V -0.06 V 5.06 V 

0~10 V 10 V -0.12 V 10.12 V 

-10~10 V 20 V 

1.2% 

-10.24 V 10.24 V 
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(2) Alarm indication for each channel 

Alarm detection signal is saved at UXY.20 and UXY.21. If input signal returns to the within of effective range, alarm detection 
signal also returns to the normal status automatically.   
(X: base number, Y: slot number) 

 
UXY.20: upper limit 

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 
Initial value 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
Allocation - - - - - - - - CH

7 
CH
6 

CH
5 

CH
4 

CH
3 

CH
2 

CH
1 

CH
0 

 
BIT Description 
0 Normal 
1 Upper limit alarm 

 
UXY.21: lower limit 

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 
Initial value 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
Allocation - - - - - - - - CH

7 
CH
6 

CH
5 

CH
4 

CH
3 

CH
2 

CH
1 

CH
0 

 
BIT Description 
0 Normal 
1 Lower limit alarm 

 
 
 



 
 
 
 
 
Chapter 3 Installation and Wiring 
 

 

3-1 

Chapter 3 Installation and Wiring 
 

3.1 Installation 
 

3.1.1 Installation environment 
This product is of high reliance regardless of installation environment. However, for the sake of reliance and stability of the 
system, please pay attention to those precautions described below. 

 

1) Environmental conditions 

- To be installed on the control panel waterproof and dustproof. 

- No continuous impact or vibration shall be expected. 

- Not to be exposed to the direct sunlight. 

- No dew shall be caused by rapid temperature change. 

- Ambient temperature shall be kept 0-55℃.  

 

2) Installation work 

- No wiring waste is allowed inside PLC when wiring or drilling screw holes. 

- To be installed on a good location to work on. 

- Don’t let it installed on the same panel as a high-voltage device is on. 

- Let it kept at least 50㎜ away from duct or near-by module. 

- To be grounded in an agreeable place free from noise. 

 

 

3.1.2 Precautions for handling 
Precautions for handling Analog input module are as described below from the opening to the installation. 
 
1) Don’t let it dropped or shocked hard. 
2) Don’t remove PCB from the case. It will cause abnormal operation 
3) Don’t let any foreign materials including wiring waste inside the top of the module when wiring. Remove foreign materials if 

any inside. 
4) Don’t install or remove the module while powered on. 
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3.2 Wiring 
 

3.2.1 Precautions for wiring  
1) Don’t let AC power line near to Analog input module’s external input sign line. With an enough distance kept away between, 

it will be free from surge or inductive noise. 
2) Cable shall be selected in due consideration of ambient temperature and allowable current, whose 

  size is not less than the max. cable standard of AWG22 (0.3㎟). 
3) Don’t let the cable too close to hot device and material or in direct contact with oil for long, which will cause damage or 

abnormal operation due to short-circuit. 
4) Check the polarity when wiring the terminal. 
5) Wiring with high-voltage line or power line may produce inductive hindrance causing abnormal operation or defect. 
 

3.2.2 Wiring examples 

1) Voltage input 

 

 

2) Current input 

 

 

 
*1) Use a 2-core twisted shielded wire. AWG 22 is recommended for the cable standard.  
*2) XGF-AD16A’s current input resistance is 250 Ω (typ.).  
*3) XGF-AD16A’s voltage input resistance is 1 MΩ (min.).  
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3) Wiring example of 2-wire sensor/transmitter (current input) 
       

 

 
 

-. Run the channel to be used only. 
-. Analog input module does not provide power for the input device. Use an external power supplier. 

 
 

4) Wiring example of 4- wire sensor/transmitter (voltage/current input) 

 
 

+

R

4-Wire 
transmitter

4-Wire 
transmitter

-

CH0

CH15 +

-

R

R

R
*3R

R

*2

*2 *3

*1

*1

 
 

 
-. Start the channel to be used only. 
-. Analog input module does not provide power for the input device. Use an external power supplier. 

 
* 1) Use a 2-core twisted shielded wire. AWG 22 is recommended for the cable standard.  
* 2) XGF-AD16A’s current input resistance is 250 Ω (typ.).  
* 3) XGF-AD16A’s voltage input resistance is 1 MΩ (min.).  
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5) Relationship between voltage input accuracy and wiring length 

In voltage input, the wiring (cable) length between transmitter or sensor and module has an effect on digital-converted 
values of the module as specified below; 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

      Where, 
        

Rc: Resistance value due to line resistance of cable 
        
       Rs: Internal resistance value of transmitter or sensor 
 
       Ri: Internal resistance value (1㏁) of voltage input module 
  
       Vin: Voltage allowed to analog input module  
 
       % Vi: Tolerance of converted value (%) due to source and cable length in voltage input 
 
 

                 ( )[ ]RiRcRs
VsRiVin

+×+
×

=
2

  

 
 

1001% ×⎟
⎠
⎞

⎜
⎝
⎛ −=

Vs
VinVi %  

   
 
 
 

Notes  

In current input, there will be no accuracy tolerance caused by cable length and internal resistance of the 
Source. 

Vs 

Rs Rc

Rc
Ri 

Load Analog Input (voltage) 

Vin 
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Chapter 4 Operation Setting 
 

4.1 Operation Procedures  
 

The processing for the operation is as shown in Fig. 4.1.  
 

 
[Fig. 4. 1] Procedures for the operation 
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4.2 Operation Parameters Setting  
 

Analog input module’s operation parameters can be specified through XG5000’s [I/O parameters]. 

 

4.2.1 Settings 

For the user’s convenience of Analog input module, XG5000 provides GUI (Graphical User Interface) for parameters setting of 

Analog input module. Setting items available through [I/O parameters] on the XG5000 project window are as described below in 

the table 4.1. 
[Table 4. 1] Function of [I/O Parameters] 

Item Details 

[I/O parameters] (1) Specify the following setting items necessary for the module operation. 

(a) Channel Enable/Disable setting 

(b) Setting analog input range 

(c) Digital output data format setting 

(d) Average process method setting  

(e) Average value setting 

(2) The data specified by user through S/W package will be saved on Analog input 

module when [I/O Parameters] are downloaded. In other words, the point of time 

when [I/O Parameters] are saved on Analog input module has nothing to do with 

PLC CPU’s status RUN or SPOP.  

 

4.2.2 How to use [I/O Parameters]  
(1) Run XG5000 to create a project. (Refer to XG5000 program manual for details on how to create the project) 
(2) Double-click [I/O parameters] on the project window. 
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(3) On the ‘I/O parameters setting’ screen, find and click the slot of the base Analog input module is installed on. 16-channel voltage 
type of Analog input module is installed on Base No.0, Slot No.4 in this description. 

 
 

(4) Click the arrow button on the screen above to display the screen where an applicable module can be selected. Search for the 
applicable module to select. 

 

 
(5) After the module selected, click [Details] 
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(6) A screen will be displayed for you to specify parameters for respective channels as shown below. Click a desired item to display 
parameters to set for respective items. 

 

 

 

(a) Channel status: Select Disable or Enable 
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(b) Input range: Select the range of analog input voltage or current as desired. Analog input module provides 4 voltage input 
ranges and 2 current input ranges. 

 

 

 

 

(c) Output type: Select the type of output data. 4 formats are available in total. 
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(d) Average processing: Set the average processing type. 4 methods are available. 
 

  
 

 

 

(e) Average value: This field is activated when Average processing field is set as Time-Avr, Count-Avr, Weighted-Avr except 
Sampling. If you double-click Average value field, you can input value. 16~16000 range for Time-Avr, 2~64000 range for 
Count-Avr and 0~99 range for Weighted-Avr. If the value exceeds that range, input is not available.  
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(f) How to select the whole channels to change parameters: Click and check the radio button in the parameters item in 
order to change the whole channels to identical setting value. And then change the parameters of an optional channel to 
change the parameters of the whole channels at a time. Fig. 4.2 shows an example that Channel Status is changed to 
whole channels ‘Enable’ by means of this function. 

   

[Fig. 4. 2] Parameters change of the whole channels  
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4.3 Special Module Monitoring Functions  
 

Functions of Special Module Monitoring are as described below in table 4.3. 
 

[Table 4.3] Functions of Special Module Monitoring  

Item Details Remark 
[Special Module 

Monitoring] 
(1) Monitor/Test 

Through applicable XG5000 menu of [Monitor] -> [Special Module 
Monitoring], A/D converted value can be monitored and the 
operation of Analog input module can be tested. 

(2) Monitoring the max./min. value  
The max./min. value of the channel can be monitored during Run. 
However, the max./min. value displayed here is based on the 
present value shown on the screen. Accordingly, when 
[Monitoring/Test] screen is closed, the max./min. value will not be 
saved. 

- 

 

Notes  

The screen may not be normally displayed due to insufficient system resource. In such a case, close the screen and finish 
other applications in order to restart XG5000. 
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4.4 Precautions 
 

(1) The parameters specified for the test of Analog input module on the “Monitor Special Module” screen of [Monitor Special 

Module] will be deleted the moment the “Monitor Special Module” screen is closed. In other words, the parameters of Analog 

input module specified on the “Monitor Special Module” screen will not be saved in [I/O parameters] located on the left tab of 

XG5000. 

 

 

 

(2) Test function of [Monitor Special Module] is provided for user to check the normal operation of Analog input module even without 
sequence programming. If Analog input module is to be used for other purposes than a test, use parameters setting function in 
[I/O parameters]. 

Not saved in [I/O 
parameters] 
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4.5 Special Module Monitoring  
 

4.5.1 Start of [Special Module Monitoring]  
Go through [Online] -> [Connect] and [Monitor] -> [Special Module Monitoring] to start. If the status is not [Online], [Special 
Module Monitoring] menu will not be active. 

  

 
 

4.5.2 How to use [Special Module Monitoring] 

 (1) With XG5000 connected to PLC CPU (on-line status), click [Monitor] -> [Special Module Monitoring] to display ‘Special Module List’ 

screen as in Fig. 5.1 showing base/slot information in addition to special module type. The module installed on the present PLC 

system will be displayed on the list dialog box. 

 

 

[Fig. 5. 1] Screen of [Special Module List]  

 



 

 

 

 
 
Chapter 4 Operation Setting 
 

 

4-11 

(2) Select Special Module in Fig. 5.1 and click [Module Information] to display the information as in Fig. 5.2.  

 

[Fig. 5. 2] Screen of [Special Module Information] 
 
(3) Click [Monitor] on the “Special Module” screen in Fig. 5.1 to display [Special Module Monitoring] screen as in Fig. 5.3, where 4 

options are available such as [Reset max./min. value], [Start Monitoring], [Test] and [Close]. Analog input module’s output value 
and max./ min. value are displayed on the monitoring screen at the top of the screen, and parameters items of respective 
modules are displayed for individual setting on the test screen at the bottom of the screen. 

 
[Fig. 5. 3] [Special Module Monitoring] screen 

 

(a) [Start Monitoring]: Click [Start Moitoring] to display A/D converted value of the presently operated channel. Fig. 5.4 is the 
monitoring screen displayed when the whole channels of analog input module are in Stop status. In the present value 
field at the screen bottom, presently specified parameters of Analog input module are displayed. 
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[Fig. 5. 4] Execution screen of [Start Monitoring] 

 

(b) [Test]: [Test] is used to change the presently specified parameters of Analog input module. Click the setting value at the 
bottom field of the screen to change parameters. Fig. 5.5 will be displayed after [Test] is executed with channel 0’s input 
voltage range changed to 1 ~ 5 V in the state of input not wired. 

 

 
[Fig. 5. 5] Execution screen of [Test] 
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(c) [Reset Max./Min. value]: The max./min. value field at the upper screen shows the max. value and the min. value of A/D 
converted value. Click [Reset max./min. value] to initialize the max./min. value. Fig.5.6 is after [Reset max./min. value] 
button is clicked in the Fig. 5.5, where channel 0’s A/D converted value can be checked as reset. 

 

 

[Fig. 5. 6] Execution screen of [Reset max./min. value]  
 

(d) [Close]: [Close] is used to escape from the monitoring/test screen. When the monitoring/test screen is closed, the max. 
value, the min. value and the present value will not be saved any more.  
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4.6 Register U Devices  
 

This section describes the automatic registration function of the U device in the XG5000.  
 

4.6.1 Register U devices  
Register the variables for each module referring to the special module information that is set in the I/O parameter. The user can 
modify the variables and comments. 

 

[Procedure] 
(1) Select the special module type in the [I/O parameter setting] window. 

 

 
 

(2) Double click ‘Variable/Comment’ from the project window  
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(3) Select [Edit] -> [Register U Device]. 
 

 
 

(4) Click ‘Yes’  
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(5) As shown below, the variables are registered. 
 

 
 

4.6.2 Save variables  
(1) The contents of ‘View Variable’ can be saved as a text file.  
(2) Select [Edit] -> [Export to File]. 
(3) The contents of ‘View variable’ are saved as a text file.  
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4.6.3 View variables 
(1) The example program of XG5000 is as shown in below.   

 

 

 

(2) Select [View] -> [Variables]. The devices are changed into variables. 
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(3) Select [View] -> [Devices/Variables]. Devices and variables are both displayed. 
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(4) Select [View] -> [Device/Comments]. Devices and comments are both displayed. 
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Chapter 5 Configuration and Function of Internal Memory (For XGK) 
Analog input module has the internal memory to transmit/receive data to/from PLC CPU. 

 

5.1 Internal Memory Configuration  
Configuration of internal memory is as described below. 

5.1.1 I/O area of A/D converted data  
I/O area of A/D converted data is as displayed in Table 5.1. 

 
[Table 5. 1] I/O area of A/D converted data  

Device assigned Details R/W Ref. 

UXY.00.0 
UXY.00.F 

Module ERROR flag  
Module READY flag 

R  

UXY.01.0 
UXY.01.1 
UXY.01.2 
UXY.01.3 
UXY.01.4 
UXY.01.5 
UXY.01.6 
UXY.01.7 
UXY.01.8 
UXY.01.9 
UXY.01.A 
UXY.01.B 
UXY.01.C 
UXY.01.D 
UXY.01.E 
UXY.01.F 

CH0 Run flag 
CH1 Run flag 
CH2 Run flag 
CH3 Run flag 
CH4 Run flag 
CH5 Run flag 
CH6 Run flag 
CH7 Run flag 
CH8 Run flag 
CH9 Run flag 
CH10 Run flag 
CH11 Run flag 
CH12 Run flag 
CH13 Run flag 
CH14 Run flag 
CH15 Run flag 

R  

UXY.02 CH0 digital output value R 
UXY.03 CH1 digital output value R 
UXY.04 CH2 digital output value R 
UXY.05 CH3 digital output value R 
UXY.06 CH4 digital output value R 
UXY.07 CH5 digital output value R 
UXY.08 CH6 digital output value R 
UXY.09 CH7 digital output value R 
UXY.10 CH8 digital output value R 
UXY.11 CH9 digital output value R 
UXY.12 CH10 digital output value R 
UXY.13 CH11 digital output value R 
UXY.14 CH12 digital output value R 
UXY.15 CH13 digital output value R 
UXY.16 CH14 digital output value R 
UXY.17 CH15 digital output value R 
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Device assigned Details R/W Ref. 

UXY.18.0 
UXY.18.1 
UXY.18.2 
UXY.18.3 
UXY.18.4 
UXY.18.5 
UXY.18.6 
UXY.18.7 
UXY.18.8 
UXY.18.9 
UXY.18.A 
UXY.18.B 
UXY.18.C 
UXY.18.D 
UXY.18.E 
UXY.18.F 

Flag to detect CH0 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH1 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH2 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH3 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH4 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH5 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH6 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH7 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH8 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH9 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH10 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH11 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH12 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH13 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH14 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH15 disconnection (1 ~ 5 V or 4 ~ 20 mA)

R  

UXY.19.0 Flag to request error clear W 
Less than OS 
version 1.01 

UXY.20.0 
UXY.20.1 
UXY.20.2 
UXY.20.3 
UXY.20.4 
UXY.20.5 
UXY.20.6 
UXY.20.7 
UXY.20.8 
UXY.20.9 
UXY.20.A 
UXY.20.B 
UXY.20.C 
UXY.20.D 
UXY.20.E 
UXY.20.F 

CH0 alarm upper limit 
CH1 alarm upper limit 
CH2 alarm upper limit 
CH3 alarm upper limit 
CH4 alarm upper limit 
CH5 alarm upper limit 
CH6 alarm upper limit 
CH7 alarm upper limit 
CH8 alarm upper limit 
CH9 alarm upper limit 
CH10 alarm upper limit 
CH11 alarm upper limit 
CH12 alarm upper limit 
CH13 alarm upper limit 
CH14 alarm upper limit 
CH15 alarm upper limit 

R 
More than OS 
version 1.02 
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Device assigned Details R/W Ref. 

UXY.21.0 
UXY.21.1 
UXY.21.2 
UXY.21.3 
UXY.21.4 
UXY.21.5 
UXY.21.6 
UXY.21.7 
UXY.21.8 
UXY.21.9 
UXY.21.A 
UXY.21.B 
UXY.21.C 
UXY.21.D 
UXY.21.E 
UXY.21.F 

CH0 alarm lower limit 
CH1 alarm lower limit 
CH2 alarm lower limit 
CH3 alarm lower limit 
CH4 alarm lower limit 
CH5 alarm lower limit 
CH6 alarm lower limit 
CH7 alarm lower limit 
CH8 alarm lower limit 
CH9 alarm lower limit 
CH10 alarm lower limit 
CH11 alarm lower limit 
CH12 alarm lower limit 
CH13 alarm lower limit 
CH14 alarm lower limit 
CH15 alarm lower limit 

R 
More than OS 
version 1.02 

UXY.22.0 Flag to request error clear W 
More than OS 
version 1.02 

※ R/W is to denote Read/Write if available from PLC program.  
 
(1) In the device assigned, X stands for the Base No. and Y for the Slot No. on which module is installed. 
(2) In order to read ‘CH1 digital output value’ of Analog input module installed on Base No.0, Slot No.4, it shall be displayed as 

U04.03. 
 

 
(a) Base number setting range: 0 ~ 7 

      (b) Slot number setting range: 0 ~ 15 
 
 

(3) In order to read ‘Flag to detect CH4 disconnection’ of Analog input module installed on Base No.0, Slot No.5, it shall be 
displayed as U05.10.4. 
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5.1.2 Operation parameters setting area  

Notes  

Operation parameter of analog input module can be set through [I/O Parameter] of XG5000. 
For convenience, setting parameter of analog input module is provided GUI(Graphical User Interface) method at 
XG5000. 

 

Setting area of Analog input module’s Run parameters is as described in Table 5.2. 
 

[Table 5. 2] Setting area of Run parameters  
Memory address 
Hex Dec 

Details R/W Remarks 

0H 0 Channel enable/disable setting  
1H 1 Setting ranges of input voltage/current 1 
2H 2 Setting ranges of input voltage/current 2 
3H 3 Setting ranges of input voltage/current 3 
4H 4 Setting ranges of input voltage/current 4 
5H 5 Output data format setting 1 
6H 6 Output data format setting 2 
7H 7 Average process designation 1 
8H 8 Average process designation 2 
9H 9 Ch0 average value designation 
AH 10 Ch1 average value designation 
BH 11 Ch2 average value designation 
CH 12 Ch3 average value designation 
DH 13 Ch4 average value designation 
EH 14 Ch5 average value designation 
FH 15 Ch6 average value designation 
10H 16 Ch7 average value designation 
11H 17 Ch8 average value designation 
12H 18 Ch9 average value designation 
13H 19 Ch10 average value designation 
14H 20 Ch11 average value designation 
15H 21 Ch12 average value designation 
16H 22 Ch13 average value designation 
17H 23 Ch14 average value designation 
18H 24 Ch15 average value designation 
19H 25 Error code 

 

1AH 26 Hold last value 

R/W

More than 
OS version 

1.02 
. 
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5.2 A/D Converted Data I/O Area  
 

5.2.1 Module READY/ERROR flag (UXY.00, X: Base No., Y: Slot No.) 
1)  UXY.00.F: It will be ON when PLC CPU is powered or reset with A/D conversion ready to process 

      A/D conversion. 
2)  UXY.00.0: It is a flag to display the error status of Analog input module. 

 

 

 

 

 

 

 

 

 

 

5.2.2 Run channel flag (UXY.01, X: Base No., Y: Slot No.) 
The area where Run information of respective channels is saved 

 

 

 

 

 

 

 

 

 

5.2.3 Digital output value (UXY.02 ~ UXY.17, X: Base No., Y: Slot No.) 
1)  A/D converted-digital output value will be output to buffer memory addresses 2 ~ 17 (UXY.02 ~ UXY.17) for respective 

channels. 
2)  Digital output value will be saved in 16-bit binary. 

                              

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Channel # digital output value 

                                

 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

R 

D 

Y 

— — — — — — — — — — — — — —

E 

R 

R 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

C

H

15 

C

H

14

C

H

13 

C

H

12 

C

H

11 

C

H

10 

C

H

9

C

H

8

C

H

7

C

H

6

C

H

5

C

H

4

C

H

3

C

H

2

C

H

1 

C

H

0

Run channel information 

Bit ON (1): During Run Bit Off (0): Operation Stop 

Error information 

Bit ON (1): Error Bit Off (0): Normal
Module READY 

Bit ON (1): READY Bit Off (0): NOT READY

UXY.00 

UXY.01 

UXY.02 ~ UXY.17 
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Address Details 

Address No.2 CH0 digital output value 

Address No.3  CH1 digital output value 

Address No.4  CH2 digital output value 

Address No.5  CH3 digital output value 

Address No.6  CH4 digital output value 

Address No.7  CH5 digital output value 

Address No.8  CH6 digital output value 

Address No.9 CH7 digital output value 

Address No.10 CH8 digital output value 

Address No.11 CH9 digital output value 

Address No.12 CH10 digital output value 

Address No.13 CH11 digital output value 

Address No.14 CH12 digital output value 

Address No.15 CH13 digital output value 

Address No.16 CH14 digital output value 

Address No.17 CH15 digital output value 

 

 

5.2.4 Flag to detect disconnection (UXY.18.Z, X: Base No., Y: Slot No., Z: Channel No.) 
1)  Detection sign of disconnection for respective input channels is saved in UXY.18. 
2)  Each bit will be set to 1 if an assigned channel is detected as disconnected, and it will be back to 0 if connected back. In 

addition, each bit can be used to detect the disconnection in the user program together with execution conditions. 
 

 

 

 

 

 

 

BIT Description 

0 Normal 

1 disconnection 

 

 

5.2.5 Flag to request error clear (UXY.19.0, X: Base No., Y: Slot No.) 
1)  If a parameters setting error occurs, address No.22’s error code will not be automatically erased even if parameters are 

changed correctly. At this time, turn the ‘error clear request’ bit ON to delete address No.22’s error code and the error 
displayed in XG5000’s [System Monitoring]. In addition, RUN LED which blinks will be back to On status. 

2)  The ‘flag to request error clear’ shall be used surely together with UXY.00.0 attached thereon for guaranteed Normal 
operation. Its application shall be as shown below in Fig. 5.1. 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

C

H 

1

5 

C

H

14

C

H 

13 

C

H 

12 

C

H 

11 

C

H 

10 

C

H

9

C

H

8

C

H

7

C

H

6

C

H

5

C

H

4

C

H

3

C

H

2

C

H

1 

C

H

0 

UXY.18 
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[Fig. 5. 1] How to use the flag 

 

 

5.2.6 Flag to request error clear (UXY.22.0, X: base number, Y: slot number) 
(1) In more than OS version 1.02, address UXY.22.0 is used for error clear request flag. Except address, all functions are same with 

error clear request flag used at previous version.  
(2) In less than OS version 1.02, use address UXY.19.0 for error clear request flag 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

— — — — — — — — — — — — — — —

E

C

R

Flag to request error clear (UXY.19.0) 

Bit ON (1): Error clear request, Bit Off (0): Error clear standing-by 

UXY.19.0 
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5.3 Operation Parameters Setting Area  
 

 1 word is assigned for each address in the internal memory, which can be displayed in 16 bits.▶  
 If each bit of 16 bits configuring the address is On, let it set to “1”, and if it is Off, let it set to “0” so to realize the respective ▶

functions.  
 

 

5.3.1 How to specify the channel to use (address No.0) 
1)  Allowed/Prohibited A/D conversion can be set for respective channels. 
2)  Set the unused channel Prohibited from converted so to reduce the conversion cycle for respective channels. 
3)  If the channel to use is not specified, all the channels will be set to Prohibited. 
4)  Allowed/Prohibited A/D conversion is as specified below. 

 
 

 

 

 

 

 

BIT Description 

0 Disable 

1 Enable 

 

 

5.3.2 How to specify the range of input voltage/current (address No.1) 
1)  The range of analog input voltage/current can be specified for respective channels. 
2)  If the analog input range is not specified, the range of all the channels will be set to 4 ~ 20 mA. 
3)  Setting range of analog input voltage/current is as specified below. 

 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0
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H 

7 
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H 

6 
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H 

5 

C 

H 

4 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 
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BIT Description 
0000 4 mA ~ 20 mA 
0001 0 mA ~ 20 mA 
0010 1 V ~ 5 V 
0011 0 V ~ 5 V 
0100 0 V ~ 10 V 
0101 -10 V ~ 10 V 

 

5.3.3 How to specify the range of output data (address No.5~ address No.6) 
1)  The range of digital output data for analog input can be specified for respective channels. 
2)  If the output data range is not specified, the range of all the channels will be set to 0 ~ 16000. 
3)  Setting range of digital output data range is as specified below. 
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BIT Description 
00 0 ~ 16000 
01 -8000 ~ 8000 
10 Precise Value 
11 0 ~ 10000 

 Address “3” 

Address“4” 

Address“5” 

 Address”6” 
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Precise value has the following digital output range about analog input range. 
 

(a) Current 
 

     Analog input 
 
Digital output 

4 ~ 20 ㎃ 0 ~ 20 ㎃ 

Precise Value 4000 ~ 20000 0 ~ 20000 
 

(b) Voltage 
 

     Analog input 
 
Digital output 

-10 ~ 10 V 0 ~ 10 V 0 ~ 5 V 1 ~ 5 V 

Precise Value -10000 ~ 10000 0 ~ 10000 0 ~ 5000 1000 ~ 5000 
 

 

5.3.4 How to specify average process (address No.7~address No.8) 
1)  Allowed/Prohibited filter process can be specified for respective channels. 
2)  If the filter process is not specified, all the channels will be sampled. 
3)  Setting of the filter process is as specified below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

BIT Description 
00 Sampling 
01 Time average 
10 Count average 
11 Weighted average 
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5.3.5 How to specify average value (address No.9 ~ 24) 
(1) Setting range of average value is as follows. 

(a) Time average setting range: 16 ~ 16000(ms) 
(b) Count average setting range: 2 ~ 64000(times) 
(c) Weighted average setting range: 1 ~ 99(%) 

 

(2) In case other value exceeding the setting range is specified, (1) Error No. 60# will be displayed if    time average range 
exceeded, and (2) Error No. 70# will be displayed if count average range exceeded (3) Error No. 80# will be displayed if weighted 
average value range exceeded on the display address of the respective error codes. 
At this time, the default of average process will be applied and calculated. 
(# at error code means channel where error occurs.)  

(3) Time/Count/Weighted average process value setting is as follows 
 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

— — — — — — — — Ch# average constant 

  

 

 

 

Address Contents 

Address 9 Ch0 average process value setting 

Address 10 Ch1 average process value setting 

Address 11 Ch2 average process value setting 

Address 12 Ch3 average process value setting 

Address 13 Ch4 average process value setting 

Address 14 Ch5 average process value setting 

Address 15 Ch6 average process value setting 

Address 16 Ch7 average process value setting 

Address 17 Ch8 average process value setting 

Address 18 Ch9 average process value setting 

Address 19 Ch10 average process value setting 

Address 20 Ch11 average process value setting 

Address 21 Ch12 average process value setting 

Address 22 Ch13 average process value setting 

Address 23 Ch14 average process value setting 

Address 24 Ch15 average process value setting 

Address “9 ~ 24” 

Time average process value setting range is 16 ~ 16000 
Count average process value setting range is 2 ~ 64000 
Weighted average process value setting range is 1 ~ 99 
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5.3.6 Error code (address No.25) 
1)  Error codes detected from Analog input module will be saved. 
2)  Error types and details are as specified below. 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

— — — — — — — — Error code 

  

 

 

Error code 
(DEC) Error details Remarks 

0 Normal Run RUN LED on 

11 Module error (ASIC RAM or Register Error) 

20 Module error (A/D Conversion Error) 

RUN LED flickers every 
0.2 sec. 

1## 
Module error (Offset value with the range of 4 ~ 20 mA is set 
greater than or equal to Gain value.) 

2## 
Module error (Offset value with the range of 0 ~ 20mA is set 
greater than or equal to Gain value.) 

3## 
Module error (Offset value with the range of 1 ~ 5V is set 
greater than or equal to Gain value.) 

4## 
Module error (Offset value with the range of 0 ~ 5V is set 
greater than or equal to Gain value.) 

5## 
Module error (Offset value with the range of 0 ~ 10V is set 
greater than or equal to Gain value.) 

6## 
Module error (Offset value with the range of -10 ~ 10V is set 
greater than or equal to Gain value.) 

7## Time average setting range exceeded  

8## Count average setting range exceeded 

9## Weighted average setting range exceeded 

RUN LED flickers every 
1 sec. 

 # of the error code stands for the channel with error found.※  
 Refer to ※ 9.1 for more details on error codes. 

 
3)  If 2 or more errors occur, the module will not save other error codes than the first error code found. 
4)  If an error found is corrected, use the ‘flag to request error clear’ (refer to 5.2.5), or let power OFF  ON in order to stop LED 

blinking and to delete the error code. 

Refer to the table below for detailed error codes.

Address “25” 
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5.3.7 Hold last value (Address 26) 
(1) If you enable this function, when input value exceeds the effective range, holds the last value. For example, in case of 4~20mA, if 

input signal change from 10mA to 3mA shortly, channels holds output value corresponding to 10mA.  
(2) If this function is enabled, channel indicates digital output value within effective range. For effective range, refer to chapter 2.4 I/O 

conversion characteristic.  
(3) This function is available in the following input range.  

(a) 4 ~ 20 mA 
(b) 0 ~ 20 mA 

(4) Setting is as follows. 
.  

  
 

 

 

 

 

 

BIT Description 

0 Disable 

1 Enable 
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Chapter 6 Programming (For XGK) 
 

6.1 Basic Program 
 

- Describes how to set about operation condition at internal memory of analog input module. 
- Analog input module is equipped at slot 2. 
- IO occupation point of analog input module is 16. (changeable type)  
- Initial setting condition is one time input and initial setting is saved at internal memory of analog input module. 

 

6.1.1 Program example using [I/O Parameter] setting 
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` 

 

 

6.1.2 Program example using PUT/GET instruction 
 

 

 

 

 

Module READY Execution contact point 

Slot No. 

Internal memory address 

Device to save 

No. of data to read 

Device having data to send 

Device to save data 

Module ready 

Execution  
contact point 

Channel RUN signal 

Slot No. 

Internal memory address 

Setting data 

No. of data to read 
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6.2 Read/Write of Operation Parameters Setting Area  
Configuration of the internal memory is described as below. 

6.2.1 Read of operation parameters setting area (GET, GETP instruction) 

 

 

 

 

                                           

                              

< Difference between GET instruction and GETP instruction > 
GET  : always executed with execution condition On  (                  ) 
GETP : executed with execution condition of operation start (                  ) 

 

If Analog input module is installed on Base No.0 and Slot No.3, and internal memory addresses No.0 & 1’s data in 
Analog input module is read to D0 and D1 of CPU module, 

 

 
(Address) D area of CPU module                          Internal memory    (Address)    

D0 CH enable/disable setting CH enable/disable setting 0 

D1 Range setting of input voltage/ 
current  

Range setting of input voltage/ 
current 1 

 - -  

 - -  

 - 

 

-  

 
 

 

 

Type Description Area available 

n1 Slot No. the special module is installed on Integer 

n2 Start address of setting area of special module’s Run parameters to read 
data. Integer 

D Device’s start address with saved data to read M, P, K, L, T, C, D, #D

n3 Number of words data to read Integer 

  GET     n1    n2     D     n3 

GET instruction 
Execution condition 

 

Type 

Ex. 
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6.2.2 Write of operation parameters setting area (PUT, PUTP instruction) 

 

 

 

 

 

Type Description Area available 

n1 Slot No. the special module is installed on Integer 

n2 Start address of special module’s internal memory to write data. Integer 

S Device’s start address or integer with saved data to write. M,P,K,L,T,C,D,#D 

n3 Number of words data to write Integer 

  

                             < Difference between PUT instruction and PUTP instruction > 
 
PUT  : always executed with execution condition On      (                  ) 

               PUTP : executed with execution condition of operation start (                  ) 
 

 If Analog input module is installed on Base No.0 and Slot No.6, and CPU module’s data of D10~D13 is written on 
internal memory addresses 7~10 of Analog input module, 

 

 

(Address)   D area of CPU module                           Internal memory       (Address)    

D10 
Average processing 

enable/disable setting 1 
Average processing 

enable/disable setting 1 
12 

D11 
Average processing 

enable/disable setting 2 
Average processing 

enable/disable setting 2 
13 

D12 CH0 average value setting CH0 average value setting 14 

D13 CH1 average value setting CH1 average value setting 15 

 - 

 

-  

 

 

 

 

 

PUT instruction 
Execution condition 

  PUT     n1    n2     S     n3 

Type 

Ex. 
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6.3 Application Program 
 

6.3.1 Program to sort A/D converted value in size (I/O slot fixed-points assigned: based on 64) 

 

(1) System configuration 
 

 

 

 

 

 

 

(2) Details of initial setting  
 

No. Item Details of initial setting 
Internal 
memory 
address 

Value to write on internal 
memory 

1 Used CH CH0, CH2, CH4 0 ‘h0015’ or ‘21’ 
2 Input range -10 ~ 10 V 1, 2 ‘hFFFF’ or ‘65535’ 
3 Output data range 0 ~ 16000 3 ‘h0000’ or ‘0’ 

4 Average process 
CH2: Count average 
CH4: Time average 

4 ‘h0120’ or ‘288’ 

CH2 count average value: 100 (times) 7 ‘h0064’ or ‘100’ 
5 Average value 

CH4 time average value: 200(ms) 9 ‘h00C8’ or ‘200’ 

 

(3) Program description 
(a) If CH 0’s digital value is less than 12000, Contact No.0 (P00080) of relay output module installed on Slot No.2 will be On 
(b) If CH 2’s digital value is greater than 13600, Contact No.2 (P00082) of relay output module installed on Slot No.2 will be On. 
(c) If CH 4’s digital value is greater than or equal to 12000 and less than or equal to 13600, Contact No.4 (P00086) of relay 

output module installed on Slot No.2 will be On. 
 (d) If CH 4’s digital value is equal to 13600, Contact No.5 (P00085) of relay output module installed on Slot No.2 will be On 

XGP- 

ACF2 

XGK- 

CPUS 

XGI- 

D24A 

XGF- 

AD16A

XGQ- 

RY2A
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(4) Program 

(a) Program example using [I/O parameters] setting 

                      

 

 

 

 

 

 

 

 

Module ready Execution contact point 

Internal memory address 

Slot No. 

Device to save 

No. of data to read 
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(b) Program example using PUT/GET instruction  
 

 

 

Module ready Execution contact point Slot No. 

Internal memory address 

Setting data 

No. of word to write 

Device to save 

No. of data to read 
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6.3.2 Program to output error codes of analog input module to BCD display  
(1) System configuration 
 

 

 

 

 

 

 

 

 
 
 
 (2) Details of initial setting  

(a) Used CH: CH 0 
(b) Analog input current range: DC 4 ~ 20 mA  
(c) Time average process setting: 100 (ms) 
(d) Digital output data range: 0 ~ 16000 
 

(3) Program description  
(a) If P00000 is On, A/D conversion will be initially specified. 
(b) If P00001 is On, A/D converted value and error code will be saved respectively on D00000 and D00001. 
(c) If P00002 is On, applicable error code will be output to digital BCD display. (P00040 ~ P0004F) 
 

(4) Program  
(a) Program example through [I/O parameters] setting  

 

 

XGP- 

ACF2 

XGK- 

CPUS 

XGI- 

D24A 

XGQ- 

RY2A 

XGF- 

AD16A

Digital BCD display 
(error display) 

XGQ- 

RY2A

 

Initial value setting

Error code output to BCD 

P0000 

P000

P0002 

A/D converted value & 
error code saved 
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(b) Program example using PUT/GET instruction  
 

 

 

 

  

 

Module ready Execution contact point 

CH RUN signal 

Change error code into BCD 
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Chapter 7 Configuration and Function of Global variable (For XGI/XGR) 
 

7.1 Global Variable (Data area) 
 

7.1.1 A/D conversion data IO area configuration 
Indicates A/D conversion data IO area at table 7.1 

[Table 7. 1] A/D conversion data IO area 

Global variable Memory 
allocation Contents Read/Write

_xxyy_ERR  
_xxyy_RDY 

%UXxx.yy.0 
%UXxx.yy.15 

Module ERROR flag 
Module READY flag 

Read 

_xxyy_CH0_ACT  
_xxyy_CH1_ACT  
_xxyy_CH2_ACT  
_xxyy_CH3_ACT  
_xxyy_CH4_ACT  
_xxyy_CH5_ACT  
_xxyy_CH6_ACT  
_xxyy_CH7_ACT  
_xxyy_CH8_ACT 
_xxyy_CH9_ACT 
_xxyy_CH10_ACT 
_xxyy_CH11_ACT 
_xxyy_CH12_ACT 
_xxyy_CH13_ACT 
_xxyy_CH14_ACT 
_xxyy_CH15_ACT 

%UXxx.yy.16 
%UXxx.yy.17 
%UXxx.yy.18 
%UXxx.yy.19 
%UXxx.yy.20 
%UXxx.yy.21 
%UXxx.yy.22 
%UXxx.yy.23 
%UXxx.yy.24 
%UXxx.yy.25 
%UXxx.yy.26 
%UXxx.yy.27 
%UXxx.yy.28 
%UXxx.yy.29 
%UXxx.yy.30 
%UXxx.yy.31 

CH 0 RUN flag 
CH 1 RUN flag 
CH 2 RUN flag 
CH 3 RUN flag 
CH 4 RUN flag 
CH 5 RUN flag 
CH 6 RUN flag 
CH 7 RUN flag 
CH 8 RUN flag 
CH 9 RUN flag 
CH 10 RUN flag 
CH 11 RUN flag 
CH 12 RUN flag 
CH 13 RUN flag 
CH 14 RUN flag 
CH 15 RUN flag 

Read 

_xxyy_CH0_DATA 
_xxyy_CH1_DATA 
_xxyy_CH2_DATA 
_xxyy_CH3_DATA 
_xxyy_CH4_DATA 
_xxyy_CH5_DATA 
_xxyy_CH6_DATA 
_xxyy_CH7_DATA 
_xxyy_CH8_DATA 
_xxyy_CH9_DATA 
_xxyy_CH10_DATA 
_xxyy_CH11_DATA 
_xxyy_CH12_DATA 
_xxyy_CH13_DATA 
_xxyy_CH14_DATA 
_xxyy_CH15_DATA 

%UWxx.yy.2 
%UWxx.yy.3 
%UWxx.yy.4 
%UWxx.yy.5 
%UWxx.yy.6 
%UWxx.yy.7 
%UWxx.yy.8 
%UWxx.yy.9 
%UWxx.yy.10 
%UWxx.yy.11 
%UWxx.yy.12 
%UWxx.yy.13 
%UWxx.yy.14 
%UWxx.yy.15 
%UWxx.yy.16 
%UWxx.yy.17 

CH 0 Digital output value (conversion value) 
CH 1 Digital output value (conversion value) 
CH 2 Digital output value (conversion value) 
CH 3 Digital output value (conversion value) 
CH 4 Digital output value (conversion value) 
CH 5 Digital output value (conversion value) 
CH 6 Digital output value (conversion value) 
CH 7 Digital output value (conversion value) 
CH 8 Digital output value (conversion value) 
CH 9 Digital output value (conversion value) 
CH 10 Digital output value (conversion value) 
CH 11 Digital output value (conversion value) 
CH 12 Digital output value (conversion value) 
CH 13 Digital output value (conversion value) 
CH 14 Digital output value (conversion value) 
CH 15 Digital output value (conversion value) 

Read 
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Global variable Memory 
allocation Contents Read/Write

_xxyy_CH0_IDD 
_xxyy_CH1_IDD 
_xxyy_CH2_IDD 
_xxyy_CH3_IDD 
_xxyy_CH4_IDD 
_xxyy_CH5_IDD 
_xxyy_CH6_IDD 
_xxyy_CH7_IDD 
_xxyy_CH8_IDD 
_xxyy_CH9_IDD 
_xxyy_CH10_IDD 
_xxyy_CH11_IDD 
_xxyy_CH12_IDD 
_xxyy_CH13_IDD 
_xxyy_CH14_IDD 
_xxyy_CH15_IDD 

%UXxx.yy.288 
%UXxx.yy.289 
%UXxx.yy.290 
%UXxx.yy.291 
%UXxx.yy.292 
%UXxx.yy.293 
%UXxx.yy.294 
%UXxx.yy.295 
%UXxx.yy.296 
%UXxx.yy.297 
%UXxx.yy.298 
%UXxx.yy.299 
%UXxx.yy.300 
%UXxx.yy.301 
%UXxx.yy.302 
%UXxx.yy.303 

CH 0 disconnection detection flag 
CH 1 disconnection detection flag 
CH 2 disconnection detection flag 
CH 3 disconnection detection flag 
CH 4 disconnection detection flag 
CH 5 disconnection detection flag 
CH 6 disconnection detection flag 
CH 7 disconnection detection flag 
CH 8 disconnection detection flag 
CH 9 disconnection detection flag 
CH 10 disconnection detection flag 
CH 11 disconnection detection flag 
CH 12 disconnection detection flag 
CH 13 disconnection detection flag 
CH 14 disconnection detection flag 
CH 15 disconnection detection flag 

Read 

_xxyy_ERR_CLR %UXxx.yy.304 Error clear request flag Write 
_xxyy_CH0_HOOR 
_xxyy_CH1_HOOR 
_xxyy_CH2_HOOR 
_xxyy_CH3_HOOR 
_xxyy_CH4_HOOR 
_xxyy_CH5_HOOR 
_xxyy_CH6_HOOR 
_xxyy_CH7_HOOR 
_xxyy_CH8_HOOR 
_xxyy_CH9_HOOR 
_xxyy_CH10_HOOR 
_xxyy_CH11_HOOR 
_xxyy_CH12_HOOR 
_xxyy_CH13_HOOR 
_xxyy_CH14_HOOR 
_xxyy_CH15_HOOR 

%UXxx.yy.320 
%UXxx.yy.321 
%UXxx.yy.322 
%UXxx.yy.323 
%UXxx.yy.324 
%UXxx.yy.325 
%UXxx.yy.326 
%UXxx.yy.327 
%UXxx.yy.328 
%UXxx.yy.329 
%UXxx.yy.330 
%UXxx.yy.331 
%UXxx.yy.332 
%UXxx.yy.333 
%UXxx.yy.334 
%UXxx.yy.335 

CH0 alarm upper limit 
CH1 alarm upper limit 
CH2 alarm upper limit 
CH3 alarm upper limit 
CH4 alarm upper limit 
CH5 alarm upper limit 
CH6 alarm upper limit 
CH7 alarm upper limit 
CH8 alarm upper limit 
CH9 alarm upper limit 
CH10 alarm upper limit 
CH11 alarm upper limit 
CH12 alarm upper limit 
CH13 alarm upper limit 
CH14 alarm upper limit 
CH15 alarm upper limit 

Read 
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Global variable Memory 
allocation Contents Read/Write

_xxyy_CH0_LOOR 
_xxyy_CH1_LOOR 
_xxyy_CH2_LOOR 
_xxyy_CH3_LOOR 
_xxyy_CH4_LOOR 
_xxyy_CH5_LOOR 
_xxyy_CH6_LOOR 
_xxyy_CH7_LOOR 
_xxyy_CH8_LOOR 
_xxyy_CH9_LOOR 
_xxyy_CH10_LOOR 
_xxyy_CH11_LOOR 
_xxyy_CH12_LOOR 
_xxyy_CH13_LOOR 
_xxyy_CH14_LOOR 
_xxyy_CH15_LOOR 

%UXxx.yy.336 
%UXxx.yy.337 
%UXxx.yy.338 
%UXxx.yy.339 
%UXxx.yy.340 
%UXxx.yy.341 
%UXxx.yy.342 
%UXxx.yy.343 
%UXxx.yy.344 
%UXxx.yy.345 
%UXxx.yy.346 
%UXxx.yy.347 
%UXxx.yy.348 
%UXxx.yy.349 
%UXxx.yy.350 
%UXxx.yy.351 

CH0 alarm lower limit 
CH1 alarm lower limit 
CH2 alarm lower limit 
CH3 alarm lower limit 
CH4 alarm lower limit 
CH5 alarm lower limit 
CH6 alarm lower limit 
CH7 alarm lower limit 
CH8 alarm lower limit 
CH9 alarm lower limit 
CH10 alarm lower limit 
CH11 alarm lower limit 
CH12 alarm lower limit 
CH13 alarm lower limit 
CH14 alarm lower limit 
CH15 alarm lower limit 

Read 

_xxyy_ERR_CTR %UXxx.yy.352 Error clear request flag (V1.02) Write 
 
※ At the device allocation, xx means base number and yy means slot number where module is installed. 
 

 

 

 

7.1.2 How to use global variable 

- In order to register global variable, there are two method, auto registration after setting I/O parameter       

 at project window and batch registration after setting I/O parameter 

 

(1) I/O parameter registration 

    - Registers module you want to use at I/O parameter 

  (a) Double-click I/O parameter of project window 
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  (b) Select XGF-AD16A module at I/O parameter window 

  
 

(c) Set parameter by pressing [Details] and select [OK] 

 

 



 
 
 
 
 
Chapter 7 Configuration and Function of Global variable (For XGI/XGR) 

 

7-5 

  (d) Select [Yes] 

    - Auto-register global variable of module set in I/O parameter 

 

 

(e) Global variable auto registration check 

 - Double-click Global/Direct Variable of project window  
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(2) Global variable registration 

  - Registers global variable set in I/O parameter 

  (a) Double-click Global/Direct Variable of project window  

   

 

  (b) Select [Register Special Module Variables] at menu [Edit] 
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(3) Local variable registration 
- Registers variable among registered global variable you want to use as local variable. 

 
(a) Double-click local variable to use in the following scan program. 

 
  

(b) Click right button of mouse in the right local variable window and select “Add EXTERNAL variable”.  
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(c) Select local variable to add at Global View on “Add External Variable” window (“All” or “Base, slot”).  
 

  -View All 

 

 

- View per base, slot 

 

 

(d) The following is example selecting digital input value (_0000_CH0_DATA) of “Base00, Slot00”. 
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(4) How to use local variable on program 

- It describes the added global variable at local program. 
- The following is example getting the conversion value of CH0 of Analog input module to %MW0. 

 

 (a) At part reading A/D conversion data to %MW0 by using the following MOVE function, double-click variable part ahead of IN, 

then “Select Variable” window shows up.  

 

 

 

(b) Select global variable at variable type at Select Variable window. And select relevant base (0 base, 0 slot) at global 

variable view item.  

         

(c) Double-click or select _0000_CH0_DATA corresponding to CH0 A/D conversion data and click [OK]. 

      

Double-click 
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(d) The following figure is result adding global variable corresponding to CH0 A/D conversion value.  
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7.2.1 PUT/GET Function Block use area (Parameter area) 

It indicates operation parameter setting area of Analog input module at table 7.2. 
 

[Table 7. 2] Operation parameter setting area 

Global variable Contents Instruction 

_Fxxyy_AVG_SEL1 
_Fxxyy_AVG_SEL2 
_Fxxyy_CH_EN 

Average process method setting 1 
Average process method setting 2 
Enable CH 

PUT 

_Fxxyy_CH0_AVG_VAL 
_Fxxyy_CH1_AVG_VAL 
_Fxxyy_CH2_AVG_VAL 
_Fxxyy_CH3_AVG_VAL 
_Fxxyy_CH4_AVG_VAL 
_Fxxyy_CH5_AVG_VAL 
_Fxxyy_CH6_AVG_VAL 
_Fxxyy_CH7_AVG_VAL 
_Fxxyy_CH8_AVG_VAL 
_Fxxyy_CH9_AVG_VAL 
_Fxxyy_CH10_AVG_VAL 
_Fxxyy_CH11_AVG_VAL 
_Fxxyy_CH12_AVG_VAL 
_Fxxyy_CH13_AVG_VAL 
_Fxxyy_CH14_AVG_VAL 
_Fxxyy_CH15_AVG_VAL 

CH0 average value 
CH1 average value 
CH2 average value 
CH3 average value 
CH4 average value 
CH5 average value 
CH6 average value 
CH7 average value 
CH8 average value 
CH9 average value 
CH10 average value 
CH11 average value 
CH12 average value 
CH13 average value 
CH14 average value 
CH15 average value 

PUT 

_Fxxyy_DATA_TYPE1 
_Fxxyy_DATA_TYPE2 
_Fxxyy_IN_RANGE1 
_Fxxyy_IN_RANGE2 
_Fxxyy_IN_RANGE3 
_Fxxyy_IN_RANGE4 

Output data type setting 1 
Output data type setting 2 
Input current/voltage range setting 1 
Input current/voltage range setting 2 
Input current/voltage range setting 3 
Input current/voltage range setting 4 

PUT 

_Fxxyy_ERR_CODE Error code GET 
※ At the device allocation, xx means base number and yy means slot number where module is installed 

7.2 PUT/GET Function Block use area (Parameter area) 
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7.2.2 PUT/GET instruction 
 
(1)PUT instruction 

 

    PUT     

Writing data to special module 
 

 

Function Block Description 

 

UINT

PUT

DONE

BASE

SLOT

MADDR

STAT

BOOL

USINT

UINT

USINT

*ANY DATA

REQBOOL

 

 

Input 

REQ : execute function when 1 
 BASE  : set base position 
 SLOT  : set slot position 
 MADDR : module address 
 DATA : data to save module 
 
Output  
DONE  : Output 1 when normal 
 STAT  : Error information 
 

 

  *ANY: WORD, DWORD, INT, USINT, DINT, UDINT type available among ANY type 
 

  ■ Function  
Read data from designated special module 

 

Function Block Input(ANY) type Description 
PUT_WORD WORD Save WRD data into the designated module address (MADDR). 

PUT_DWORD DWORD 
Save DWORD data into the designated module address 
(MADDR). 

PUT_INT INT Save INT data into the designated module address (MADDR). 
PUT_UINT UINT Save UNIT data into the designated module address (MADDR). 
PUT_DINT DINT Save DINT data into the designated module address (MADDR). 

PUT_UDINT UDINT Save UDINT data into the designated module address (MADDR). 
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(2) GET instruction 
 

    GET     

Reading from special module data  
 

 

Function block Description 

 

UINT

GET

DONE

BASE

SLOT

MADDR

STAT

BOOL

USINT

UINT

USINT *ANYDATA

REQBOOL

 

 

Input 

 REQ : execute function when 1 
 BASE  : set base position 
 SLOT  : set slot position 
 MADDR : module address 

512(0x200) ~ 1023(0x3FF) 
 
Output 
DONE  : output 1 when normal 
 STAT  : Error information 
 DATA : data to read from module 
 

 

 *ANY: WORD, DWORD, INT, UINT, DINT, UDINT type available among ANY type 
 

■ Function 
Read data from designated special module 
 

Function Block Output(ANY) type Description 

GET_WORD WORD 
Read data as much as WORD from the designated module address 
(MADDR). 

GET_DWORD DWORD 
Read data as much as DWORD from the designated module 
address (MADDR). 

GET_INT INT 
Read data as much as INT from the designated Module address 
(MADDR). 

GET_UINT UINT 
Read data as much as UNIT from the designated module address 
(MADDR). 

GET_DINT DINT 
Read data as much as DINT from the designated module address 
(MADDR). 

GET_UDINT UDINT 
Read data as much as UDINT from the designated module address  
(MADDR). 
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7.2.3 Example using PUT/GET instruction  

(1) Enable channel 
(a) You can enable/disable A/D conversion per channel 
(b) Disable channel not using to reduce the conversion cycle per channel 
(c) When channel is not designated, all channels are set as not used 
(d) Enable/disable of A/D conversion is as follows  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

C 

H 

15 

C 

H 

14 

C 

H 

13 

C 

H 

12 

C 

H 

11 

C 

H 

10 

C 

H 

9

C 

H 

8 

C 

H 

7 

C 

H 

6 

C

H

5

C

H

4

C

H

3

C

H

2

C

H

1 

C

H

0

16#0003 : 0000 0000 0000 0011 

 

                         CH3, CH2, CH1, CH0 

Bit Description 

0 Stop 

1 Run 

 

 
(e) The value in B4~B15 is ignored. 
(f) The right figure is example enabling CH0~CH1 of A/D module equipped at slot 0. 
 

 

(2) Input voltage/current range setting 
(a) You can set input voltage/current range per channel 
(b) When analog input range is not set, all channels are set as 1 ~ 5V (4 ~ 20mA)  
(c) Setting of analog input voltage/current range is as follows. 
 

- The following is example setting CH0~CH1 as 1~5V and CH2~CH3 as 0~10V  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

CH3 CH2 CH1 CH0 

16#4422 : 0100 0100 0010 0010 
 CH3,  CH2, CH1,  CH0 

Bit Description 
0000 4 mA ~ 20 mA 
0001 0 mA ~ 20 mA 
0010 1 V ~ 5 V 
0011 0 V ~ 5 V 
0100 0 V ~ 10 V 
0101 -10 V ~ 10 V 

 

 

Set channel 
to use 

Input range 
setting 
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(3) Out put data range setting 

(a) Digital output data range about analog input can be set per channel.  
(b) When output data range is not set, all channels are set as -32000~32000.  
(c) Setting of digital output data range is as follows 
  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

CH3 CH2  CH1 CH0 

16#2012 : 0010 0000 0001 0010 
             CH3,  CH2,  CH1,  CH0 

Bit Description 
00 0~ 16000 
01 -8000~8000 
10 Precise Value 
11 0~10000 

 

 
Precise value has the following digital output range about analog input range 
1) Current 
 

 

 

 

 

2) Voltage 

  

 

Analog input 
 
Digital output 

4 ~ 20 ㎃ 0 ~ 20 ㎃ 

Precise Value 4000 ~ 20000 0 ~ 20000 

Analog input 
 
Digital output 

-10 ~ 10V 0 ~ 10V 0 ~ 5V 1 ~ 5V 

Precise Value 
-10000 ~ 
10000 

0 ~ 10000 0 ~ 5000 1000 ~ 5000 
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(4) Filter process setting 
(a) You can enable/disable filter process per channel 
(b) Filter process is not set, all channels are set as enable 
(c) Setting of filter process is as follows 
(d) The following figure is example using filter about CH4 

 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

CH7 CH6 CH5 CH4 CH3 CH2 CH1 CH0 

Bit Description 
00 0~ 16000 
01 -8000~8000 
10 Precise Value 
11 0~10000 
  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

CH15 CH14 CH13 CH12 CH11 CH10 CH9 CH8 
 

16#0010: 0000 0000 0001 0000 
CH 3, CH 2, CH 1, CH 0 

 

(5) Filter constant setting 

(a) Initial value of filter constant is 0 
(b) Setting range of filter constant is as follows. 

Average method Setting range 
Time average 16 ~16000(ms) 
Count average 2 ~ 64000(times) 

Weighted average 1 ~ 99(%) 
 
(c) When setting value other than setting range, it indicates error number at error code indication (_F0001_ERR_CODE). At this 

time, A/D conversion value keeps previous data. (# means the channel where error occurs at error code) 
 (d) Setting of filter constant is as follows 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

        CH# average value 
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Address Details 

9 CH0 average process value setting 

10 CH1 average process value setting 

11 CH2 average process value setting 

12 CH3 average process value setting 

13 CH4 average process value setting 

14 CH5 average process value setting 

15 CH6 average process value setting 

16 CH7 average process value setting 

17 CH8 average process value setting 

18 CH9 average process value setting 

19 CH10 average process value setting 

20 CH11 average process value setting 

21 CH12 average process value setting 

22 CH13 average process value setting 

23 CH14 average process value setting 

24 CH15 average process value setting 
 

 

※ At the device allocation, xx means base number and yy means slot number where module is installed 
 

 

 

Note  

Before you set Time/Count average value, enable the average process and select average method 

(Time/Count).  

 

Range is different according to average process method
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(6) Error code 
(a) Saves error code detected at Analog input module 
(b) Error type and contents are as follows 
(c) The following figure is program example reading error code 
  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

— — — — — — — — Error code 
 

Error code 
(Decimal) 

Error contents Remark 

0 Normal RUN RUN LED on 
11 Module error (ASIC RAM or Register error) 
20 Module error (A/D Conversion Error) 

RUN LED flickers 
every 0.2s 

1## 
Module error (Offset value of 4~20mA range is set as 
larger or equal than gain value) 

2## 
Module error (Offset value of 0~20mA range is set as 
larger or equal than gain value) 

3## 
Module error (Offset value of 1~5V range is set as 
larger or equal than gain value) 

4## 
Module error (Offset value of 0~5V range is set as 
larger or equal than gain value) 

5## 
Module error (Offset value of 0~10V range is set as 
larger or equal than gain value) 

6## 
Module error (Offset value of -10~10V range is set as 
larger or equal than gain value) 

7## Time average setting range exceeded 
8## Count average setting range exceeded 
9## Weighted average setting range exceeded 

RUN LED flickers 
every 1s 

 
※ At error code, # indicates channel where error occurs 
※ For more detail error code, refer to 9.1 

(d) In case two error codes occurs, module saves first occurred error code and later occurred error code is not saved 
(e) In case error occurs, after modifying error, use “Error clear request flag”(referring to 5.2.5), restart power to delete error code 

and stop LED flicker 
 

 
 



 

 

 

 

 

Chapter 8 Programming (For XGI/XGR) 
 

 

8-1 

Chapter 8 Programming (For XGI/XGR) 
 

8.1 Basic Program  
 

- How to specify Run condition details of Analog input module’s internal memory will be described. 
- Analog input module is as installed on Slot 2. 
- I/O assigned points of Analog input module is 16 points (changeable). 
- Initial value specified will be saved on the internal memory of Analog input module through one time of input under the initial setting 

condition. 

 

8.1.1 Program example using [I/O parameters] setting  
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CH3 output 

CH2 output 

CH1 output 

CH0 output 

Execution 
contact Execution  

Execution  
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8.1.2 Program example using PUT/GET instruction  
 

Execution 
contact 
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Execute  
output 

CH1 output 

CH2 output 

CH3 output 

Error code 
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8.2 Application Program  
 

8.2.1 Program to sort A/D converted value in size (I/O slot fixed-points assigned: based on 64) 
(1) System configuration 
 
 

 

 

 

 

(2) Details of initial setting 
 

No. Item Details of initial setting  
Internal 
memory 
address

Value to write on internal 
memory 

1 Used CH CH0, CH2, CH3 0 ‘h000D’ or ‘13’ 
2 Input range -10 ~ 10 V 1 ‘h5505’ or ‘21765’ 
3 Output data range -10000 ~ 10000 2 ‘h0000’ or ‘0’ 
4 Average process CH0,2,3(weighted, count, time) 3 ‘h1204’ or ‘4612’ 

CH0 weighted averaging value: 50(%) 4 ‘h0032’ or ‘50’ 
CH2 count averaging value: 100(times) 6 ‘h0064’ or ‘100’ 5 Average value 

CH3 time averaging value: 200(ms) 7 ‘h00C8’ or ‘200’ 

 

(3) Program description  
(a) If CH 0’s digital value is less than 12000, Contact No.0 (%QX0.2.0) of relay output module installed on Slot No.2 will be On  
(b) If CH 2’s digital value is greater than 13600, Contact No.2 (%QX0.2.2) of relay output module installed on Slot No.2 will be On 
(c) If CH 3’s digital value is greater than or equal to 12000 and less than or equal to 13600, Contact No.4 (%QX0.2.4) of relay 

output module installed on Slot No.2 will be On. 
(d) If CH 3’s digital value is equal to 13600, Contact No.5 (%QX0.2.5) of relay output module installed on Slot No.2 will be On  

XGP- 

ACF2 

XGI- 

CPUU 

XGI- 

D22A 

XGF- 

AD16A

XGQ- 

RY2A
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(4) Program  

Program example using [I/O parameters] setting 
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Execution Contact Execution

Execution  

Error code

Compare 

Compare 
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8.2.2 Program to output error codes of analog input module to BCD display 
(1) System configuration  

 

 

 

 

 

 

 

 

 

(2) Details of initial setting  
(a) Used CH: CH 0 
(b) Analog input current range: DC 4 ~ 20 mA  
(c) Time average process setting: 100 (ms) 
(d) Digital output data range: 0 ~ 16000 
 

(3) Program description  
(a) If %IX0.0.0 is on, A/D conversion will be initially specified. 
(b) If %IX0.0.1 is on, A/D converted value and error code will be saved respectively on DATA and DATA1. 
(c) If %IX0.0.2 is on, applicable error code will be output to digital BCD display (%QW0.3.0). 
 

(4) Program   
(a) Program example through [I/O parameters] setting 

 

XGP- 

ACF2 

XGK- 

CPUS 

XGI- 

D24A 

XGQ- 

RY2A 

XGF- 

AD16A

Digital BCD display 
(error display) 

XGQ- 

RY2A

 

Initial value setting 

Error code output to BCD 

P0000 

P0001

P0002 

A/D converted value & 
error code saved 
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Chapter 9 Troubleshooting 
Details and diagnosis of errors which occur while analog input module is used will be described. 

 

9.1 Error Codes 
 

Errors which occur when Analog input module’s RUN LED blinks are as described in Table 9.1. 

Error code detected at analog input module is saved at address 25. 

 
[Table 9. 1] List of error codes 

 
Error code 

(Dec) 
Description  RUN LED status 

10  Module error (ASIC Reset Error) 
11  Module error (ASIC RAM or Register Error) 
20  Module error (A/D Conversion Error) 
30  Module error (EEPROM Error) 

Flickers every 
0.2 sec. 

1## 
Module error (Offset value with the range of 4 ~ 20 mA is set greater than 
or equal to Gain value.) 

2## 
Module error (Offset value with the range of 0 ~ 20 mA is set greater than 
or equal to Gain value.) 

3## 
Module error (Offset value with the range of 1 ~ 5 V is set greater than or 
equal to Gain value.) 

4## 
Module error (Offset value with the range of 0 ~ 5 V is set greater than or 
equal to Gain value.) 

5## 
Module error (Offset value with the range of 0 ~ 10 V is set greater than or 
equal to Gain value.) 

6## 
Module error (Offset value with the range of -10 ~ 10 V is set greater than 
or equal to Gain value.) 

7## Time average setting range exceeded 
8## Count average setting range exceeded 
9## Weighted average setting range exceeded 

Flickers every 
1 sec. 

 

Notes  
(1) # of the error code stands for the channel with error found. 
(2) If 2 or more errors occur, the module will not save other error codes than the first error 

code found. 
(3) Use the flag to request error clear to delete the error code from the sequence program. 

(Refer to 9.2.5) 
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9.2 Troubleshooting 
 

9.2.1 RUN LED blinks 

 

 

 
Error Code 

(Dec) Error Details Action 

1## 

2## 

3## 

4## 

5## 

6## 

Module Offset/Gain error 

Let the power ON/OFF again. If the error occurs again, 
 it seems to be a module defect. Contact the nearest agency 

 or LS branch office. 
 

7## 
Time average setting range 

exceeded 
Change time average setting value within 16 ~ 16000. 

8## 
Count average setting range 

exceeded 
Change count average setting value within 2 ~ 64000. 

9## 
Weighted average setting range 

exceeded 
Change weighted average setting value within 1 ~ 99. 

 
※ # of the error code stands for the channel with error found. 
 

RUN LED flickers. 

RUN LED flickers every 0.2 sec. 

Let the power ON/OFF again. If the error occurs again, 
 it seems to be a module defect. Contact the nearest agency 

 or LS branch office. 

RUN LED flickers every 1 sec. 

 It is Run parameters setting error. Check the error code to take 
action against as follows in the table below. 

Yes

No

Yes
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9.2.2 RUN LED is Off 

 

 

 

 

9.2.3 CPU module cannot read A/D converted value 

 

 

RUN LED is Off. 

Analog input module is installed on the base 
correctly 

Correctly install Analog input module on the base. 

Capacity of power module installed on the base 
is sufficient. 

Check the system configuration again with each module’s 
consumed current calculated correctly 

Normally operated if Analog input module with 
error is changed to another module 

Error due to other module than Analog input 
module Refer to CPU manual for more details.

Module defect Go to 9.2.5 

No

Yes

No

Yes

Yes

No

CPU module can not read A/D converted value. 

Used channel is set correctly. 
Check the channel number to use and let it correctly 

specified. 

Specified CH’s input terminal wiring is correct. 

Refer to 3.2.2 to correct wiring. 

Module defect Go to 9.2.5. 

No

Yes

No

Yes
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9.2.4 Relationship discordant between analog input value & digital output value 

 

 
 

 

9.2.5 H/W error of Analog input module  

 

 
 

9.2.6 Status check of Analog input module through XG5000 system monitor 
Module type, module information, O/S version and module status of Analog input module can be checked through XG5000 
system monitoring function. 
 

1) Execution sequence 
Two routes are available for the execution. 
(1) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to display [Module 

Information]. 
(2) [Monitor] -> [System Monitoring] -> And Double-click the module screen. 

 

2) Module information 
(1) Module type: shows the information of the module presently installed. 
(2) Module information: shows the O/S version information of Analog input module. 
(3) O/S version: shows the O/S prepared date of Analog input module. 
(4) Module status: shows the present error code. (Refer to 9.1 for detailed error codes) 

 Let the power ON/OFF again. If the error occurs again, it seems to 
be a module defect. Contact the nearest agency or LS branch office. 

 

Refer to 3.2.2 to correct wiring. 

Go to 9.2.5 

Analog input terminal’s wiring is correct. 

Each CH’s analog input type and connected input 
type is correct as specified. 

Check the used analog input type if set correctly. No 

Yes 

Relationship between analog input value and 
digital output value is not discordant. 

No 

Yes 
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Appendix 1 Dimension 
 

Appendix 1.1 Dimension 
Unit: ㎜ 

 

 

 

 



 

 

 

 

 

Warranty and Environmental Policy 
 

 

 

     

 
 

Warranty 
 
 
1. Warranty Period 

 The product you purchased will be guaranteed for 18 months from the date of manufacturing.  
 
2. Scope of Warranty 
   Any trouble or defect occurring for the above-mentioned period will be partially replaced or repaired. However, please note the following 

cases will be excluded from the scope of warranty.  
  

(1) Any trouble attributable to unreasonable condition, environment or handling otherwise specified in the manual,  
(2) Any trouble attributable to others’ products, 
(3) If the product is modified or repaired in any other place not designated by the company,  
(4) Due to unintended purposes 
(5) Owing to the reasons unexpected at the level of the contemporary science and technology when delivered.  
(6) Not attributable to the company; for instance, natural disasters or fire 
 

 
3.  Since the above warranty is limited to PLC unit only, make sure to use the product considering the safety for system configuration or 

applications.  
 
 
 

 

Environmental Policy 
 
 
     LS Industrial Systems Co., Ltd supports and observes the environmental policy as below.  
 
 
 
  

 
LS Industrial Systems considers the 
environmental preservation as the preferential 
management subject and every staff of LS 
Industrial Systems use the reasonable 
endeavors for the pleasurably environmental 
preservation of the earth.   

 
 
     

LS Industrial Systems’ PLC unit is designed to 
protect the environment. For the disposal, 
separate aluminum, iron and synthetic resin 
(cover) from the product as they are reusable.   

Environmental Management About Disposal 



 

 

■ HEAD OFFICE 
   LS tower, Hogye-dong, Dongan-gu, Anyang-si, Gyeonggi-do  

1026-6, Korea http://eng.lsis.biz 
   Tel. (82-2)2034-4689, 4888   Fax.(82-2)2034-4648  
■ LS Industrial Systems Tokyo Office >> Japan 
   Address: 16F, Higashi-Kan, Akasaka Twin Towers 17- 22,  
   2-chome, Akasaka, Minato-ku, Tokyo 107-8470, Japan 
   Tel: 81-3-3582-9128   Fax: 81-3-3582-2667 
                                          e-mail: jschuna@lsis.biz  
■ LS Industrial Systems Dubai Rep. Office >> UAE 
   Address: P.O.BOX-114216, API World Tower, 303B, Sheikh    
   Zayed road, Dubai, UAE.                e-mail: hwyim@lsis.biz 
   Tel: 971-4-3328289   Fax: 971-4-3329444 
■ LS-VINA Industrial Systems Co., Ltd. >> Vietnam 
   Address: LSIS VINA Congty che tao may dien Viet-Hung  
   Dong Anh Hanoi, Vietnam               e-mail: srjo@hn.vnn.vn 
   Tel: 84-4-882-0222   Fax: 84-4-882-0220   
■ LS Industrial Systems Hanoi Office >> Vietnam 
   Address: Room C21, 5th Floor, Horison Hotel, 40 Cat Linh,  
   Hanoi, Vietnam 
   Tel: 84-4-736-6270/1  Fax: 84-4-736-6269 
■ Dalian LS Industrial Systems co., Ltd, >> China 
   Address: No. 15 Liaohexi 3 Road, economic and technical  
   development zone, Dalian, China       e-mail: lixk@lgis.com.cn 
   Tel: 86-411-8273-7777   Fax: 86-411-8730-7560  

■ LS Industrial Systems (Shanghai) Co., Ltd. >> China 
   Address: Room E-G, 12th Floor Huamin Empire Plaza,  
   No. 726, West Yan’an Road, Shanghai, China 
   Tel: 86-21-5237-9977 
■ LS Industrial Systems(Wuxi) Co., Ltd. >> China 
    Address: 102-A National High & New Tech Industrial    
    Development Area, Wuxi, Jiangsu, China   e-mail: Xugh@lgis.com.cn 
    Tel: 86-510-534-6666   Fax: 86-510-522-4078   
■ LS Industrial Systems Beijing Office >> China 
    Address: B-tower 17th Floor, Beijing Global Trade Center building,  
    No. 36, BeiSanHuanDong-Lu,  DongCheng-District, Beijing, China 
    Tel: 86-10-5825-6025 
■ LS Industrial Systems Guangzhou Office >> China 
    Address: Room 1403, 14F, New Poly Tower, 2 Zhongshan Liu   
    Rad, Guangzhou, China                 e-mail: zhangch@lgis.com.cn 
    Tel: 86-20-8326-6754   Fax: 86-20-8326-6287    
■ LS Industrial Systems Chengdu Office >> China 
    Address: Room 2907, Zhong Yin B/D, No. 35, Renminzhong(2)-   
    Road, Chengdu, China                e-mail: hongkonk@vip.163.com 
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LS values every single customer. 

Quality and service come first at LSIS.  

Always at your service, standing for our customers. 
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